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True 32bit application
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Auto selections.
Auto summing.
Auto formatting.
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Format painter.
Drawing tools.
Data input objects.
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Technical Support 
          On the World Wide Web

Visit our website at www.techmarc.ndirect.co.uk
E-Mail us at support@techmarc.ndirect.co.uk



The SpreadPro Workbook 
When you open or create a file in SpreadPro, you are creating or opening a workbook. The workbook is 
where all your data is stored. A workbook can consist of one or more individual worksheets. Worksheets 
are useful for organizing information into separate groups. For example, you might have the year-end 
sales figures for each sales region on a different worksheet within the same workbook. Having all the 
information in one worksheet would be cumbersome; splitting it into separate files would be too 
inconvenient to work with. 
The following illustration shows a SpreadPro workbook with three worksheets:

Each of the three sheets is identified by a name displayed on a sheet tab.
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Inserting Worksheets 
By default, a workbook contains only one worksheet. However, you can easily insert additional 
worksheets.
To add worksheets:

1. Select Insert Worksheet from the Insert menu.

A new worksheet is added as the last worksheet.
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Selecting      Worksheets
Usually, you do most of your work in one worksheet at a time. This is called the active worksheet. When 
you have multiple worksheets in a workbook, you can use the mouse to click on a worksheet's tab to 
make it the active sheet. The tab is highlighted and moves on top of the other tabs.
You can save time and effort by performing some tasks on several sheets at once. For example, if you 
want all three worksheets in your workbook to have the same title information, you can select all three 
worksheets and enter the titles on the active worksheet. The titles are automatically entered in the 
corresponding cells in the other selected worksheets as well.
To select multiple worksheets:
Use one of the following key/mouse combinations, depending on whether you want to select adjacent or 
non-adjacent worksheets:
Action Result
CTRL-Click on sheet tab Selects or deselects non-adjacent sheets. Any other selected worksheets remain selected.
SHIFT-Click on sheet tab Selects all adjacent worksheets between the active worksheet and the worksheet you 
clicked on. All other worksheets are deselected.
The following illustration shows various groupings of selected worksheets:

Sheet4 is the active sheet. All other sheets are deselected.

If you hold down the Shift key and select Sheet1, all sheets between the active sheet (Sheet4) and 
Sheet1 are selected.

If you select Sheet2, it becomes the active sheet, but all sheets remain selected.

If you hold down the Control key and select Sheet3, it is deselected, but the other sheets remain selected.
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Working with a Group of Worksheets      
When you have multiple worksheets selected, you can think of them as a group of worksheets. When you
perform some actions they affect all worksheets in the group. Other actions affect only the active 
worksheet, regardless of how many worksheets are selected. 
The following actions work on all selected worksheets:

Changing cell selection
Entering values via the formula bar
Inserting rows, columns, or ranges of cells
Deleting rows, columns, or ranges of cells
Clearing rows, columns, or ranges of cells
Setting TopLeft/Row/Column header text
Setting column width
Setting row height
Moving and copying with the mouse



Inserting Multiple Worksheets      
You can insert more than one sheet at a time and at any point in the sheet tab index. The number and 
position of the inserted sheets depends on number and position of the selected sheets in the workbook.
To insert worksheets:

1. Select the worksheet immediately to the right of where you want to insert the new worksheets. 
2. Select as many worksheets to the right of that worksheet as the number of worksheets you want 

to insert. 
For example, if you want to insert two worksheets, a total of two worksheets must be selected.

3. Select Insert Sheet from the Sheet menu.
The following illustration shows this process:

Since Sheet2 and Sheet1 are selected, two additional worksheets are inserted to the left of Sheet2. 
Notice that the newly inserted worksheets are given the next available sheet names, regardless of their 
position in the sheet index list.
Inserting Worksheets 
Renaming Worksheets 



Deleting Worksheets    
To delete worksheets:

1. Select the worksheets you want to delete. 
2. Select Delete Sheets from the Sheet menu.

The following illustration shows this process:
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Renaming Worksheets 
SpreadPro provides each worksheet with a default name. You can change those names to more 
meaningfully describe the sheet's contents. For example, the sheet names in the following illustration are 
far more descriptive than the worksheet's default names.

To rename a sheet name:
1. Select Rename from the Sheet sub-menu in the Edit menu.
2. Enter the new name and click OK.

Inserting Worksheets 
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Positioning Worksheet Tabs
You may place the workbook tabs at the bottom, top, left or right of the workbook. You may also hide 
them. Use the Options dialog in the Tools menu to change the appearance of the tabs.

The following illustration shows sheet tabs displayed at the top of the workbook.



Navigating Through Worksheets 
You can navigate within individual worksheets using keyboard commands or mouse actions. In addition to
navigating through worksheets, keyboard commands allow you to perform a variety of other tasks.
Keyboard commands allow you to:

position the active cell in the worksheet
page through a worksheet
enter data typed in a cell
move the active cell within a selected range
enter and exit edit mode
recalculate a workbook
delete data from a selected cell or range

Using Keyboard Commands 
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Using Keyboard Commands 
The tables below list the keyboard commands you can use when working in SpreadPro. The following 
table lists action keys that allow you to enter and edit data, move the active cell within a selected range, 
and recalculate the workbook.
Key Description
ENTER When in edit mode, accepts the current entry. When a range is selected, if Enter Moves Down is 

set to True, accepts the current entry and moves active cell vertically to next cell in selection.

SHIFT + ENTER When in edit mode, accepts the current entry. When a range is selected, with the Enter Moves 
Down checked in the options dialog, accepts the current entry and moves active cell vertically to 
previous cell in selection.

TAB When in edit mode, accepts the current entry and moves the active cell horizontally to right.
SHIFT +TAB When in edit mode, accepts the current entry and moves the active cell horizontally to left.
F2 Enters edit mode. While in editing mode, F2 displays the Cell Text dialog box, in which you can 

enter multi-line data entries.
F9 Recalculates the workbook.
DEL May clear current selection depending on the setting of Allow Delete.
Escape Cancels current data entry or editing operation. 

The following table lists the movement keys that allow you to move the active cell within a worksheet and 
display different sections of the worksheet.
Key Description
Up Arrow Moves active cell up one row.
Down Arrow Moves active cell down one row.
Left Arrow Moves active cell left one column.
Right Arrow Moves active cell right one column.
CTRL Up/Down/Left/Right Moves to the next range of cells containing data. If there is no additional data in the 

direction in which you are moving, moves to the edge of the worksheet.
Page Up Moves up one screen.
Page Down Moves down one screen.
CTRL Page Up Moves left one screen.
CTRL Page Down Moves right one screen.
Home Goes to first column of current row.
End Goes to last column of current row that contains data.
CTRL Home Goes to row 1 column 1.
CTRL End Goes to last row and column that contain data.

The following table lists the keys that modify the action of the movement keys.
Key Description
Scroll lock Causes the view window to scroll without changing current selection with all movement keys except

Home, End, CTRL Home, and CTRL End.
SHIFT plus any movement key Extends the current selection.
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Performing Mouse Actions
Primarily the mouse is used to select items in a worksheet at run time. The following table lists the mouse 
actions you can perform in a worksheet.
Action Description
Left-Click Moves the active cell to the pointer position.
Right-Click In the container's design mode, brings up the shortcut menu.
Left-Click in Row or Column Headings Selects entire row or column.
Left-Click in Top Left Corner Selects entire sheet.
Left Double-Click in Top Left Corner, Row Headings, Column Headings, or Worksheet tabsDisplays a dialog box that 
allows you to enter a    label for the top left corner or the column or row    heading, or a new name for the worksheet 
that was double-clicked. 
Left Double-Click , invokes in-cell editing. 
Left-Click and Drag Selects a range. If other ranges are selected, the previously selected ranges are 
unselected.
CTRL + Left-Click and Drag Selects a range. If other ranges are selected they remain selected.
SHIFT + Left-Click and Drag Extends the current selection.
CTRL + SHIFT Click on Row Headings, Column Headings, or Top Left Corner Selects the row headings, column 
headings, or top left corner of the sheet.
Drag a Selection's Copy Handle Copies the selection into the newly selected area.
Drag a Selection's Border Moves the selection to a new location.
ALT + Click and Drag an Object or Object's Selection Handles Repositions or resizes an object and aligns object 
sides with the cell grid.
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Selecting Cells
Many operations require one or more cells to be selected. There are three kinds of selections: a single 
cell, a range of cells, and multiple ranges of cells (non-adjacent). The following illustrations show the three
types of selections.

A single cell is selected.

A single range is selected.

Multiple ranges are selected.
Selecting Cells with the Mouse 
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Selecting Cells with the Mouse
The worksheet cursor is always located on a cell. The cell on which the worksheet cursor is located is 
called the active cell. The active cell is also a selection or part of a selection. Any data the user enters is 
always placed in the active cell.

To select a range of cells, click and hold the left mouse button and drag through the range you 
want to select. When a range is selected, it becomes highlighted.

To select multiple ranges, press the CTRL key while selecting a range with the mouse. Any 
previously selected ranges remain selected.
Once a range is selected, you can move the active cell within the range using the ENTER, SHIFT + 
ENTER, TAB, and SHIFT + TAB keys. When you use these keys to move the active cell, the range 
remains selected.
Selecting Cells 
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Selecting Rows and Columns
Entire rows and columns can be selected in the worksheet using the mouse. To select a row or column, 
position the pointer on the header of the row or column you want to select. When you click the header, the
row or column is selected.
You can also select all rows and columns in the worksheet. To do this, position the pointer on the top left 
header and click. 
Selecting Cells 



Worksheet Data Entry
One of the basic tasks encountered when working with a workbook is data entry. SpreadPro provides 
several methods for entering data.

Direct entry. This is the most direct method of data entry. Data can be entered directly in a 
Copying data. Two methods allow you to copy data to or from variant arrays into or from a range 

of cells in a SpreadPro worksheet.
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Adding The Formula Bar
You can enter data into a worksheet by typing directly into a cell, or by typing into the formula bar. The 
formula bar appears by default, and you can turn on or off the display of the formula bar and cell 
reference indicator in your workbook control. 

To control the display of the formula bar:
Select Formula Bar from the View menu to toggle the display of the formula bar.



Entering Multi-Line Data
A single cell can contain as many as nine lines or 256 characters of data. When entering the data, new 
lines of data are specified within the cell by entering carriage return/line feeds.

When entering data in a worksheet at run time, press F2 when editing a cell. The Cell Text dialog 
box is displayed in which you can enter the cell data. To enter a line feed, press RETURN. Click the OK 
button to accept the entry and return to normal worksheet editing.

After entering multi-line data, you may need to resize the row and column in which the entry is placed 
in order to view all the data. 

You can also enter multi-line row and column headers. 
Formatting Row and Column Headings 



Limiting Data Entry
Some applications may require that the user not be allowed to enter or edit data. To prevent data entry, 
set the Allow In Cell Editting to false in the options dialog, and hide the formula bar. Data and formula 
entry and editing is thus prevented. 
Adding the formula bar 
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Limiting Formula Entry
If you only want to prevent the entering and editing of formulas, uncheck Allow Formulas in the options 
dialog. Unchecking it does not affect the entry and editing of constant values.
Limiting Data Entry 
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Locking Cells
To set editing permissions on a per cell basis:

1. Select the cells you want to lock.
2. Select Cell Protection from the Tools menu.
3. Uncheck the Locked check box and click OK.
4. Select Enable Protection from the Sheet menu to enable protection for the entire worksheet.
5. This final step actually prevents the cells from being modified.

Note      Worksheet cells are locked by default. If you want to lock only selected cells, you must first turn 
cell protection off for the rest of the worksheet cells.
When a worksheet contains locked cells, ENTER, SHIFT-ENTER, TAB, and SHIFT-TAB advance the 
selection to the next unlocked cell.
Limiting Data Entry 
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Displaying Formulas
It is often convenient to display formula text instead of the values they produce. Checking Display 
Formulas in the Options dialog from the Tools menu causes the worksheet to display formula text instead 
of formula results. Displaying formula text can help you debug formula-related problems. 
Entering Formulas 
Formula Operators 



Using AutoFill Lists
If you frequently use lists of names, months, or days of the week in your worksheet, you can let 
SpreadPro do some of the work for you by using the autofill feature. 

SpreadPro's default autofill lists contain frequently used series of text, such as months and days of the 
week. When you enter one of the elements in these lists and drag the autofill handle, SpreadPro enters 
the rest of the data from the list as needed to fill the range you mark.

Once SpreadPro has recognized the text as an item from an autofill list, pressing TAB puts the next list 
item in the next cell to the right, or ENTER puts the next list item in the next cell below.
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Adding AutoFill Lists
To add a new autofill list:

1. Select AutoFill List... from the Data menu to display the AutoFill Lists dialog box.
By default, a new, empty line is selected in the Lists list box.

2. Type your new autofill list in the Current List list box, separating each item with a semi-colon.
3. Click Add.

Select the empty row at the end of the list and then type your new list in the Current List list box.
Note      Values recognized as data cannot be used as autofill list items, such as 1973;1974, 1a;1b, 
1%;2%.
Using AutoFill Lists 
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Deleting AutoFill Lists
To delete an autofill list:

1. Select AutoFill List... from the Data menu to display the AutoFill Lists dialog box.
2. Select the list you want to edit or delete from the Lists list box.
3. Click Delete. 

Using AutoFill Lists 
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Validating Data
Another means of limiting data entry is to specify a validation rule for a cell. A validation rule consists of a 
formula to test and text to display if the validation fails. If the formula returns True, the value is entered. If 
the formula returns a text string, the string is displayed and the value is not entered. If the formula returns 
False, the value is not entered and the validation text is displayed in an error dialog box. 
For example, you can limit the range of values a user can enter in a cell by creating a rule that fails if the 
user enters a number under 100 and displays the message "Enter a value greater than 100."

You can use relative references in validation rules. These references are considered to be relative to the 
active cell. This allows a validation rule to be properly applied to an entire range.
To create a validation rule:

1. Select the cell for which you want to create a validation rule.
2. Select Validation Rule from the Format menu to display the Validation Rule dialog box.
3. Enter a validation formula in the Rule text box.
4. Enter text to be displayed if the data fails the validation test in the Text box.
5. Click OK.

This illustration shows the validation rule created for cell A1.



This illustration shows the message displayed when the data entered in cell A1 fails the validation rule.
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The Validation Formula
The validation formula follows basically the same rules as those for defined names. It must also be a 
worksheet formula that evaluates to True or False. Following are a number of examples of validation 
formulas.

SUM(A6:A7) > A5
AND(A6>1, A6 <100)
IF (A7>1,A7<100,A7>0)
OR(ISLOGICAL (A7), A7=1,A7=0)

Validating Data 



Worksheet Data Types
Cells can contain two types of information: constant values and formulas.

Constant values are numbers, including dates and times, logical values, error values, and text.
Formulas are groups of constant values, cell references, names, functions, and operators that 

result in a new value when calculated or evaluated.
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Entering Constant Values
Numbers. Numeric entries can contain numeric characters (e.g., 1, 2, 3, 4, 5, 6, 7, 8, 9, and 0) and the 
special characters (e.g., +, -, (, ), /, $, %, ., E, and e).

Negative numbers can be preceded by a minus sign or enclosed in parentheses. 
Commas can be included in numeric entries as thousands separators.
Numeric entries containing leading dollar signs are formatted as currency.
Numeric entries containing trailing percent signs are formatted as percentages.

SpreadPro accepts numeric entries as fractions. If the fraction contains a leading integer (e.g., 1 1/3) it 
can be entered directly. If there is no leading integer, the fraction should be preceded by a zero (e.g., 0 
2/3).
Numbers larger than the cell in which they are entered are converted to scientific notation unless a 
specific format is applied.
Dates and Times. Dates and times are automatically recognized by SpreadPro. They are entered in the 
cell as values and automatically formatted. The following date and time formats are automatically 
recognized.
Entered Format Assigned
3/15/94 m/d/yy
15-Mar-94 d-mmm-yy
15-Mar d-mmm
Mar-94 mmm-yy
9:55 PM h:mm AM/PM
9:55:33 PM h:mm:ss AM/PM
21:55 h:mm
21:55:33h:mm:ss
3/15/94 21:55 m/d/yy h:mm
Text. Text is any set of characters that SpreadPro does not recognize as a number, date, or time.
Text that is wider than a cell ordinarily spills over into the cell immediately to the right. You can specify that
text should wrap within the cell by enabling word wrap in your alignment format settings.
Logical and Error Values. Logical and error values are not normally entered directly in cells; they are 
usually the result of a formula. However, entering these values can be useful for testing formulas.
The logical values that can be entered are TRUE and FALSE. The error values that can be entered are 
#N/A, #VALUE!, #REF!, #NULL!, #DIV/0!, #NUM!, and #NAME?.
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Entering    Formulas
Formulas are the basic building blocks for analyzing and calculating worksheet data. A formula is a string 
containing numbers, operators, worksheet functions, cell references, and names. A formula can contain 
as many as 1024 characters.

When you manually enter a formula in a worksheet, you must begin the entry with an equal sign 
(=). SpreadPro recognizes this entry as a formula. 
Numbers in formulas can be followed by a percent sign (%). Numbers with trailing percent signs are 
treated as percentages (e.g., 100% is evaluated as 1).
If text is encountered when a number is expected, the text is converted to a number. For example, the 
formula 1 + "3" returns 4, because "3" is converted to a number. If the text cannot be converted to a valid 
number (e.g., 1 + "Text"), #VALUE! is returned.
Likewise, if a number is encountered when text is expected, the number is converted to text. The formula 
"The number is "&3 converts to the text string "The number is 3".
The value TRUE always converts to 1; while FALSE converts to 0. If a number is encountered when a 
logical value is expected, a zero is converted to FALSE. All other numbers are converted to TRUE. If text 
is encountered when a logical value is expected, "TRUE" is converted to TRUE; "FALSE" is converted to 
FALSE. All other text returns #VALUE!.
Dates and times are recognized and converted to their serial values. For example, "10/10/94" - "10/1/94" 
equals 9.
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Formula    Operators
When creating formulas, SpreadPro provides a set of operators for specifying the type of calculation or 
evaluation to be performed on the formula data. The following table lists the formula operators.
Operator Type Operator Description
Arithmetic + Addition

- Subtraction
/ Division
* Multiplication
% Percentage
^ Exponentiation

Text & Concatenation
Comparison = Equal to

> Greater than
< Less than
>= Greater than or equal to
<= Less then or equal to
<> Not equal to

Reference :, .., . Range - produces a reference that includes all the cells between the two references (e.g., 
A1:A5 includes cells A1 and A5 and all cells in between).

, Union - produces one reference that includes the two references (e.g., A1:A10,C1:C10).
Entering Formulas 
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Operator Precedence
When combining operators in a formula, SpreadPro uses a specific order of precedence to calculate the 
formula. The following table lists the order of precedence for formula operators.
Operator Description
( ) Parentheses
:, .., . Range
, Union
- Negation (single operand)
% Percentage
^ Exponentiation
* and / Multiplication and Division
+ and - Addition and Subtraction
& Text concatenation
= < > <= >= <> Comparison
Operators of like precedence are evaluated left to right. Parentheses should be used when it is necessary
to change the order of evaluation. The following example illustrates how the result of a formula can be 
altered by adding parentheses to change the order of precedence. 

FormulaResult
1+2*37 75
(1+2)*37 111
As illustrated in the previous table, the multiplication operator (*) has higher precedence than the addition 
operator (+). It is evaluated first unless parentheses are used to force the addition to take place first.
Entering Formulas 
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Cell    References
A reference identifies a cell by referring to the row and column coordinates of the cell. References are 
based on the row and column headings. For example, A1 refers to the cell at the intersection of row 1 and
column A. References can be used in formulas to access data from a worksheet.

A range of cells is specified by placing a colon (:) between two cell references. For example, the reference
A1:C3 refers to the range anchored by cells A1 and C3. The range includes all cells in columns A, B, and 
C of rows 1, 2, and 3.
Entering Formulas 
Absolute and Relative References 
References to Other Worksheets  
References to Multiple Worksheets 
External References 
Automatically Entering Cell References 
Using Names 



Absolute and Relative      References
There are two types of cell references: relative and absolute.

Relative references point to a cell based on its relative position to the current cell. When the cell 
containing the reference is copied, the reference is adjusted to point to a new cell with the same relative 
offset as the originally referenced cell. 

Absolute references point to a cell at an exact location. When the cell containing the formula is 
copied, the reference does not change. Absolute references are designated by placing a dollar sign ($) in 
front of the row and column that is to be absolute.
References can be part absolute and part relative. These are called mixed references. The following table
lists the reference types.

Reference Type
A1 Relative reference pointing to cell A1.
$A$1 Absolute reference pointing to cell A1.
$A1 Absolute column reference, relative row reference pointing to cell A1.
A$1 Relative column reference, absolute row reference pointing to cell A1.

The reference operators can be used to specify multiple ranges in the same reference. For example, 
A1:C1,A10:C10 specifies the three cells A1, B1, and C1 and the three cells A10, B10, and C10. The 
formula =SUM(A1:C1,A10:C10) adds the values in all six cells.
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References to Other Worksheets      
You can reference cells in other worksheets. 
To reference a worksheet in the same workbook, use the following syntax:

Sheet3!A1
Cell References 
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References to Multiple      Worksheets
You can also refer to multiple worksheets, or ranges in multiple worksheets. The following example 
references cell A1 in Sheet1 and cell A1 in Sheet2. 

Sheet1C:Sheet2!A1
Important      Worksheets must be referenced in index order. For example, the reference to the sheet 
indexed 1 must come before the reference to the sheet indexed 2. Remember that the worksheet index is 
usually different that the sheet name that appears on the sheet tab. Worksheets are indexed from left to 
right, beginning with 1.
The following syntax references the range A1 to B2 in Sheet1 and the range A1 to B2 in Sheet2.

Sheet1:Sheet2!A1:B2
You can also reference multiple worksheet ranges in a different workbooks by referencing the workbook 
name at the beginning of the syntax.

[F1Book1]Sheet1:Sheet2!A1
[F1Book2]Sheet1:Sheet2!A1:B2
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External      References
References can point to cells in other workbooks. This type of reference is called an external reference. 
An external reference is created by placing a workbook name in brackets, followed by the worksheet 
name and an exclamation point, and finally a cell reference. The following table shows examples of 
external references.
Reference Type
[Sales]Sheet1!A1 Relative reference pointing to cell A1 in the first worksheet of a workbook titled Sales.
[FY91]Sheet2!$A$1 Absolute reference pointing to cell A1 in the second worksheet of a workbook titled FY91.
[Q1]Sheet1:Sheet2!$A1 Absolute column reference, relative row reference pointing to cell A1 in the first and 
second worksheets in a workbook titled Q1.
[Store1]Sheet1:Sheet4!A1:F1 Relative row and column reference, pointing to the range A1 to F1 in a workbook 
titled Store1.
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Automatically Entering Cell      References
Cell references can be automatically entered as you enter a formula. 
To automatically enter a cell reference:

1. Enter the formula to the point of the range reference. 
2. With the mouse, select the cell or range you want to reference.

The reference of the range you select is automatically placed in the formula.
When you enter a cell reference in this manner, SpreadPro assumes it is a relative reference.
Cell References 
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Worksheet      Errors
When a formula cannot be properly calculated, an error is returned in the cell. The following table lists the 
errors that can be generated.
Error Cause
#ARRAY_FORMULA! SpreadPro read in a file that contained an array formula. Since this feature is not 
supported in SpreadPro, this error value is placed in the cell which used to contain the array formula. 
#DIV/0! Divide by zero. May be caused by a reference to a blank cell or a cell containing zero.
#N/A No value is available. May be caused by inappropriate values in the formula or a reference to a cell 
containing the #N/A value.
#NAME? Name is not recognized. May be caused by a user-defined name that is not defined.
#NULL! Null intersection. An intersection of two ranges was defined that does not intersect.
#NUM! Number problem. May be caused by inappropriate numbers in functions, an iteration that cannot solve for a 
value, or a formula that results in a number too large or too small to represent.
#REF! Reference error. May be caused by referring to a cell that was deleted.
#VALUE! Wrong argument type. May be caused by entering text where a number was expected, or supplying
a range to an operator or function that was expecting a single value.
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Built-In Worksheet      Functions
SpreadPro contains a set of built-in worksheet functions that provide the ability to perform complex 
calculations with very little work.
Worksheet functions:

calculate and evaluate data
can be used alone or in a formula
are entered directly in the worksheet

Like formulas, worksheet functions return data to the cell in which they are entered.
Each function performs a specific calculation. The SQRT function is an example of a built-in function. With
this function, you can easily calculate the square root of a number. The following example calculates the 
square root of 118:

=SQRT(118)
For further information on each of the worksheet functions built-in to SpreadPro, see Worksheet 
Functions. 
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Understanding      Functions
Most worksheet functions are composed of keywords and arguments. Every worksheet function contains 
a keyword, but not all functions require arguments.

The keyword identifies the function and tells the worksheet what type of calculation or evaluation 
is performed. Each function keyword is unique.

Arguments provide the data for the function to calculate or evaluate. The arguments for a function
immediately follow the function keyword and are enclosed in parentheses.
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Entering      Functions
When entering functions in a worksheet, all functions are preceded by an equal sign (=). The leading 
equal sign tells the worksheet that the following information is to be evaluated or calculated.
The function keyword follows the equal sign. It can be entered in lowercase or uppercase characters. 
After the function is entered, the worksheet records the function keyword in uppercase characters, 
regardless of how it was entered.
If a function requires multiple arguments, the arguments are separated by commas. Some functions 
contain optional arguments. If you omit an optional argument, a default value is assumed for the 
argument.
Functions that do not require arguments still require a set of parentheses following the function keyword.
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Nesting      Functions
A function can be used as an argument for another function. When a function is used in this manner, you 
are nesting functions. The nested function must return the appropriate type of data for the function in 
which it is nested. You must also provide the necessary arguments for the nested function. 
In the following example, the AVERAGE function is used as an argument for the SUM function. In this 
case, AVERAGE is nested in SUM.

=SUM(5.23, 6.82, AVERAGE(2.45, 5.62, 7.74), 8.95, 9.01)
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Entering      Arguments
The arguments for a function can be:

Numerical values
Logical values
Text strings
Error values
References to cells or ranges

For most arguments, you can substitute a cell or range reference for the data required by an argument. 
For example, if an argument requires a number, you can substitute a reference to a cell that contains a 
number. The number in the referenced cell is used in the calculation of the function. The data in the 
referenced cell must be appropriate for the argument for which it is used.
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Syntax      Errors
If the worksheet function you enter contains syntax errors, SpreadPro does not allow the function to be 
entered. You must correct the errors before proceeding with other tasks.
Built-In Worksheet Functions 
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Using      Names
User-defined names are an easy way to identify a cell, a group of cells, a value, or a formula. For 
example, the formula "= Sales - Expenses" is much clearer than "=A10 - A6".
You can also use names to identify constants and formula expressions. For example, you might define 
the name LightSpeed as 186000. You could then use the name LightSpeed in all your formulas. Or, you 
could define the name SqRtTwo as the formula SQRT(2).
To define names:

1. If you are naming a range, select it.
2. Choose Defined Name from the Insert menu.
3. Enter the name you want to define. 
4. Enter the formula that describes the name. 

If this is a range, enter a range reference. If this is a formula, enter the formula.
5. Click Add to add the new name to the list. 

You can delete any name from the list by selecting it in the list and clicking Delete.
SpreadPro has a set of built-in names. These names are used by the print functions. The built-in names 
are listed in the following table.
Built in Name Purpose
Print_Area Defines the print area used during printing. This name can contain one or more ranges (e.g., 
A1:C3,A11:C13).
Print_Titles Defines the row and column titles that are printed on each new page. Entire rows and columns 
must be selected when you define this name.
Cell References 



Calculating      Worksheets
SpreadPro calculates cells in natural order. In natural order calculation, formulas are calculated in such a 
way that all dependencies are calculated before their dependents. This ensures that the formula results 
are always correct.
When a worksheet is edited, formula references are adjusted so they point to the correct cells. Then, 
SpreadPro determines the natural order of the formulas.
When a change is made to a cell, the formulas are recalculated to keep all worksheets in the workbook 
current, ensuring that data is always valid.
Setting Automatic Recalculation 
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Setting Automatic      Recalculation
Normally, automatic recalculation is enabled. In this mode, the worksheet is recalculated each time a cell 
is changed and system processing is idle.
For moderately sized worksheets, recalculation operations happen in a fraction of a second. But for large 
worksheets or situations where many cells are changed by code, this reorganization and recalculation 
process can slow system processing.
In these situations, it is sometimes desirable to disable automatic recalculation while your code operates 
on the worksheet. Automatic recalculation can be disabled in the recalc options dialog. After the 
completion of an operation, automatic recalculation can be enabled and the worksheet updated.
Calculating Worksheets 
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Solving Circular      References
There are some circumstances where a formula refers to its own cell, either directly or indirectly. This is 
called a circular reference. To solve a formula that contains a circular reference, iteration must be used. 
Iteration is the process of repeatedly calculating a worksheet until a specific condition is met.
The following example includes a circular reference.
Suppose your small business has 10,000 shares of stock owned by four shareholders. You decide to let a
fifth shareholder enter your partnership. In return for his investment, you give him 10 percent of the 
company. How many more shares will the company have to issue to give the new investor 10% of the 
company? 
The following illustration shows the results of this example as it is entered in a worksheet.

The formulas in B2 and B3 create a circular reference in this example worksheet.
The first worksheet shows the formula text, the second worksheet shows the results of the formulas.
Calculating Worksheets 
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Cut, Copy, and Paste Methods
Ranges of data can be edited using one of several editing methods. SpreadPro automatically adjusts cell 
references when cells are moved. Thus, the integrity of worksheet formulas remains intact.

SpreadPro maintains its own internal clipboard and also supports text on the Windows clipboard. The 
internal clipboard is more flexible than the Windows clipboard. The internal clipboard retains formulas and
allows cell references to be adjusted when cells are pasted. The Windows clipboard only holds text and 
formatting; cell references are not maintained by the Windows clipboard.
Copying Data 
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Copying Data    
You can copy data by dragging the copy handle of a selection. The copy handle is the small knob in the 
lower right corner of a selection. When you copy data using the copy handle, the pointer changes to a 
small crosshair.

The above illustration demonstrates how you can copy the number in A1 to the cells below when the copy
handle is dragged downward.
Copying Ranges 



Copying      Ranges
To Copy a Range of Data:
1. Position the pointer on the border of the selection you want to copy. 

When placed on the selection border, the pointer changes to an arrow. 
2. Press the CTRL key.
3. With the pointer on the selection border, click and drag the range.

An outline of the selected range moves as you drag the pointer. 
4. Release the mouse button at the location where you want to place the copied range.

The original range is not moved. The following illustration shows the steps required to copy a 
range.

The pointer appears an arrow when positioned on a selection border.

When you click and drag a selection border while pressing CTRL, the highlighted area moves to indicate 
the placement of the copied range.



The data in the range is copied to its new location when you release the mouse button.
Copying Data 



Select from the list whether you want to search by row order or by column order.



Select from the list whether you want to search for the string in cell formulas or values. Although you can 
locate formula and value data, you are not allowed to replace it. You are only allowed to replace data that 
actually appears within a cell.



Click here if you want the search to match case.



Click here if you want the search to match bytes. (DBCS versions of SpreadPro only.)



Click here if you want to search for a cell that contains the entire search string.



Click here to find the next occurrence of the search string in the worksheet.



Click here to cancel the search and exit the dialog.



Click here to invoke the Replace dialog.



Click here to replace this instance and search for the next instance of the string.



Click here to replace all instances of the search string.



Enter the replacement string here.



Using Drag-and-Drop Functionality to Move or Copy      Data
You can use SpreadPro's drag-and-drop functionality to move or copy data internally (within SpreadPro 
applications) and externally. 

Using Drag and Drop within SpreadPro
You can use SpreadPro's drag-and-drop functionality to easily copy or move data, objects, and charts to 
other locations within the active worksheet.
To use drag and drop within SpreadPro:

1. Select the cells that contain the data, object, or chart you want to move or copy.
2. To move the selection, point to it, and then hold down the mouse button. When the pointer 

appears,    drag the pointer to the new location. In order to place the selection on an area of the 
sheet that is not visible, move the cursor to the edge of    sheet and scroll to the appropriate 
location. Once the pointer is at the appropriate location, release the mouse button.
To copy the selection, hold down the CTRL key, point to the selected information, and then hold 
down the mouse button. When the pointer appears, drag the pointer to the new location, and then
release both the mouse button and the CTRL key. 

Using Drag and Drop with Other Applications
You can easily drag text and Windows metafile pictures onto a SpreadPro worksheet from other Windows
applications, such as Excel.
Note      The drag-and-drop functionality will only work with applications that support Windows CF_TEXT 

and CF_METAFILEPICT data. The mouse pointer will change to  to indicate that the data cannot be 
placed in the selected location. 
To drag information from another application and drop it into SpreadPro:

1. Arrange the application windows so that the source and destination documents are open and 
visible. You must be able to see the information you want to drag and the SpreadPro worksheet 
you want to place it on.

2. Select the information you want to move or copy.
3. To move the information, point to the selected information, and then hold down the mouse button.

Drag the pointer to the new location, and then release the mouse button. The pointer will change 

to  to indicate a move.
To copy the information, point to the selected information, and then hold down the mouse button. 
When the pointer appears, drag the pointer to the new location, hold down the CTRL key and 

then release the mouse button.  . 
To drag data from SpreadPro to another application:

1. Arrange the application windows so that the source and destination documents are open and 
visible. You must be able to see the data on the SpreadPro worksheet.

2. Select the information you want to move or copy. You can only move or copy CF_TEXT format 
from SpreadPro.

3. To move the information, point to the selected information, and then hold down the mouse button.
When the pointer appears, drag the pointer to the new location, and then release the mouse 

button. The pointer will change to  to indicate a move.
To copy the information, hold down the CTRL key, point to the selected information, and then hold
down the mouse button. When the pointer appears, drag the pointer to the new location, and then

release both the mouse button and the CTRL key. The pointer will change to  to indicate a 
copy.
NOTE      When dragging information out of SpreadPro, be careful when approaching the margin 
area, as the margins will scroll as you drag.



Inserting Cells, Rows, and    Columns
To insert new cells:

1. Select one of the following, depending on what you want to insert.
Range. Select a range of cells in the size and position you want to insert new cells.
Row. Select the row where you want the new row inserted by clicking on the row heading. Select 
as many rows as you want to insert. To select additional row headings, hold down SHIFT when 
you click on the heading. For example, to insert 3 rows, select three rows. 
Column. Select the column where you want the new column inserted by clicking on the column 
heading. Select as many columns as you want to insert. To select additional column headings, 
hold down SHIFT when you click on the heading. For example, to insert 3 columns, select three 
columns.

2. Select Insert from the Edit menu.
If you insert a range or columns, any existing data is shifted right. If you insert columns, any 
existing data is shifted down.



Clearing and Deleting Cells, Rows, and      Columns
You can delete or clear cells, rows, or columns. Deleting cells removes the cells and shifts the 
surrounding data to fill the space. Clearing cells leaves the cells, but deletes the data.
To delete cells:

1. Select the cells, rows, or columns you want to delete.
2. Select Delete from the Edit menu.

If you delete a range or columns, any data to the right of the deleted cells is shifted left. If you 
delete rows, any existing data below the deleted rows is shifted up.

To clear cells:
1. Select the cells, rows, or columns you want to clear.
2. Select Clear from the Edit menu to display the Clear dialog box.
3. Select All, Formats, or Values, depending on what you want to clear from the cell. All clears the 

value and its formatting. Formats leaves the value, but clears any formatting. Values clears only 
the value.

4. Click OK.
Inserting Cells, Rows, and Columns 



Sorting Data in Worksheets    
Select Sort... from the Data menu to display the sort dialog.

The Sort dialog box allows you to sort the data in the currently selected range. The dialog box allows you 
to specify sort keys, whether those sort keys are ascending or descending, and whether data is sorted by 
rows or columns.



Formatting Worksheets
SpreadPro supports a rich set of data formatting capabilities. When a worksheet is first created, all cells 
use the General format. As you enter data in the worksheet, SpreadPro determines the type of data and 
applies the appropriate format (e.g., if you enter a date, a date format is applied).
Built-in Number Formats
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Built-in Number Formats    
You can apply a number of built-in number formats by highlighting a range of cells and selecting the 
format from the Format menu.

The following table lists the built-in number formats and the result after the format is applied to a positive, 
negative, and decimal number. 

Category Format 3 -3 .3
All General 3 -3 .3
Currency $#,##0_);($#,##0) $3 ($3) $0

$#,##0_);[RED]($#,##0) $3 ($3) $0
$#,##0.00_);($#,##0.00) $3.00 ($3.00) $0.30
$#,##0.00_);[RED]$(#,##0.00) $3.00 ($3.00) $0.30

Fixed 0 3 -3 0
0.00 3.00 -3.00 0.30
#,##0 3 -3 0
#,##0.00 3.00 -3.00 0.30
#,##0_);(#,##0) 3 (3) 0
#,##0_);[RED](#,##0) 3 (3) 0
#,##0.00_);(#,##0.00) 3.00 (3.00) 0.30
#,##0.00_);[RED](#,##0.00) 3.00 (3.00) 0.30

Percent 0% 300% -300% 30%
0.00% 300.00% -300.00% 30.00%

Fraction # ?/? 3 -3 2/7
# ??/?? 3 -3 3/10

Scientific 0.00E+00 3.00E+00 -3.00E+00 3.00E-01

Custom Formatting 



Custom Formatting 
In addition to the built-in formats, you can define custom formats. Each custom format can have as many 
as four sections: one for positive numbers, one for negative numbers, one for zeros, and one for text. 
Each section is optional; the sections are separated by semicolons. The following example shows a 
custom format:

#,###;(#,###);0;"Error: Entry must be numeric"

To define a custom number format:
1. Select a range of cells to be formatted.
2. Choose Custom Number from the Format menu    to display the Custom Format dialog box.
3. Enter a format built from the custom format characters described in the table below.

The following table lists the format symbols that can be used in a custom format string.

Format Symbol Description
General Displays the number in General format.
0 Digit placeholder. If the number contains fewer digits than the format contains placeholders, the 

number is padded with 0's. If there are more digits to the right of the decimal than there are 
placeholders, the decimal portion is rounded to the number of places specified by the 
placeholders. If there are more digits to the left of the decimal than there are placeholders, the 
extra digits are retained.

# Digit placeholder. This placeholder functions the same as the 0 placeholder except the number is 
not padded with 0's if the number contains fewer digits than the format contains placeholders.

? Digit placeholder. This placeholder functions the same as the 0 placeholder except that spaces 
are used to pad the digits.

. (period) Decimal point. Determines how many digits (0's or #'s) are displayed on either side of the decimal 
point. If the format contains only #'s left of the decimal point, numbers less than 1 begin with a 
decimal point. If the format contains 0's left of the decimal point, numbers less than 1 begin with a 
0 left of the decimal point.

% Displays the number as a percentage. The number is multiplied by 100 and the % character is 
appended.

, (comma) Thousands separator. If the format contains commas separated by #'s or 0's, the number is 
displayed with commas separating thousands. A comma following a placeholder scales the 
number by a thousand. For example, the format 0, scales the number by 1000 (e.g., 10,000 would
be displayed as 10).

E- E+ e- e+ Displays the number as scientific notation. If the format contains a scientific notation symbol to the
left of a 0 or # placeholder, the number is displayed in scientific notation and an E or an e is 
added. The number of 0 and # placeholders to the right of the decimal determines the number of 
digits in the exponent. E- and e- place a minus sign by negative exponents. E+ and e+ place a 
minus sign by negative exponents and a plus sign by positive exponents.

$ - + / ( ) : space Displays that character. To display a character other than those listed, precede the character with 
a back slash (\) or enclose the character in double quotation marks (" "). You can also use the 
slash (/) for fraction formats.

\ Displays the next character. The backslash is not displayed. You can also display a character or 
string of characters by surrounding the characters with double quotation marks (" ").
The backslash is inserted automatically for the following characters: ! ^ & ` (left quote) ' (right 
quote) ~ { } = < >

* (asterisk) Repeats the next character until the width of the column is filled. You cannot have more than one 
asterisk in each format section.

_ (underline) Skips the width of the next character. For example, to make negative numbers surrounded by 
parentheses align with positive numbers, you can include the format _) for positive numbers to 
skip the width of a parenthesis.

"text" Displays the text inside the quotation marks.
@ Text placeholder. If there is text in the cell, the text replaces the @ format character.
m Month number. Displays the month as digits without leading zeros (e.g., 1-12). Can also represent

minutes when used with h or hh formats.
mm Month number. Displays the month as digits with leading zeros (e.g., 01-12). Can also represent 

minutes when used with the h or hh formats.



mmm Month abbreviation. Displays the month as an abbreviation (e.g., Jan-Dec).
mmmm Month name. Displays the month as a full name (e.g., January-December).
d Day number. Displays the day as digits with no leading zero (e.g., 1-2).
dd Day number. Displays the day as digits with leading zeros (e.g., 01-02).
ddd Day abbreviation. Displays the day as an abbreviation (e.g., Sun-Sat).
dddd Day name. Displays the day as a full name (e.g., Sunday-Saturday).
yy Year number. Displays the year as a two-digit number (e.g., 00-99).
yyyy Year number. Displays the year as a four-digit number (e.g., 1900-2078).
h Hour number. Displays the hour as a number without leading zeros (e.g., 1-23). If the format 

contains one of the AM or PM formats, the hour is based on a 12-hour clock. Otherwise, it is 
based on a 24-hour clock.

hh Hour number. Displays the hour as a number with leading zeros (e.g., 01-23). If the format 
contains one of the AM or PM formats, the hour is based on a 12-hour clock. Otherwise, it is 
based on a 24-hour clock.

m Minute number. Displays the minute as a number without leading zeros (e.g., 0-59). The m format 
must appear immediately after the h or hh symbol. Otherwise, it is interpreted as a month number.

mm Minute number. Displays the minute as a number with leading zeros (e.g., 00-59). The mm format 
must appear immediately after the h or hh symbol. Otherwise, it is interpreted as a month number.

s Second number. Displays the second as a number without leading zeros (e.g., 0-59).
ss Second number. Displays the second as a number with leading zeros (e.g., 00-59).
AM/PM am/pm A/P a/p 12-hour time. Displays time using a 12-hour clock. Displays AM, am, A,    or a for times 

between midnight and noon; displays PM, pm, P, or p for times from noon until midnight.

[h] Outputs total number of hours.
[m] Outputs total number of minutes.
[s] Outputs total number of seconds.
s.0, s.00, s.000, ss.0, ss.00, ss.000 Outputs fractional part of second.
[BLACK] Displays cell text in black.
[BLUE] Displays cell text in blue.
[CYAN] Displays cell text in cyan.
[GREEN] Displays cell text in green.
[MAGENTA] Displays cell text in magenta.
[RED] Displays cell text in red.
[WHITE] Displays cell text in white.
[YELLOW] Displays cell text in yellow.
[COLOR n] Displays cell text using the corresponding color in the color palette. n is a color in the color 

palette.
[conditional value] Each format can have as many as four sections: one each for positive numbers, negative 

numbers, zeros, and text. Using the conditional value brackets ([ ]), you can designate a different 
condition for each section. For example, you might want positive numbers displayed in black, 
negative numbers in red, and zeros in blue. The following string formats a number for these 
conditions:[>0] [BLACK]General; [<0] [RED]General; [BLUE]General

The following table shows some examples of custom number formats and numbers displayed using the 
custom formats. 

Format Cell Data Display
#.## 123.456 123.46

0.2 .2
#.0# 123.456 123.46

123 123.0
#,##0"CR";#,##0"DR";0 1234.567 1,235CR

0 0
-123.45 123DR

#, 10000 10
"Sales="0.0 123.45 Sales=123.5

-123.45 -Sales=123.5
"X="0.0;"x="-0.0 -12.34 x=-12.3
$* #,##0.00;$* -#,##0.00 1234.567 $ 1,234.57

-12.34 $ -12.34



000-00-0000 123456789 123-45-6789
"Cust. No." 0000 1234 Cust. No. 1234
;;; Anything (Not Displayed)
"The End" 123.45 The End

-123.45 -The End
text text

m-d-yy 2/3/94 2-3-94
mm dd yy 2/3/94 02 03 94
mmm d, yy 2/3/94 Feb 3, 94
mmmm d, yyyy 2/3/94 February 3, 1994
d mmmm yyyy 2/3/94 3 February 1994
hh"h" mm"m" 1:32 AM 01h 32m
h.mm AM/PM 14:56 2.56 PM
hhmm "hours" 3:15 0315 hours



Aligning      Data
SpreadPro allows you to specify how data is aligned within a cell. The standard alignment places text 
along the left edge of the cell and numbers along the right edge of the cell. Logical and error values are 
centered.
To align text:

1. Select the cells whose contents you want to align.
2. Choose Alignment from the Format menu to display the Alignment dialog box.

In this dialog box, you can specify the horizontal and vertical alignment of data in the selected 
cells. In addition, you can specify whether long strings of data can wrap to multiple lines within the
cell.



Changing Row Heights and Column      Widths
The width of columns and the height of rows can be changed.

Sizing Rows and Columns 
Fixing Rows and Columns 
Formatting Row and Column Headings 



Sizing Rows and      Columns
When you position the pointer on the right edge of a column heading or the bottom edge of a row 
heading, the pointer changes to a double arrow to indicate that the row or column can be resized. Simply 
click and drag to resize the column or row. 

If multiple rows are selected when you resize a row, all selected rows are resized as you drag a row 
border. Multiple columns can be resized in the same manner.

Double-click on the bottom border of a row heading to automatically adjust the height of all cells in the row
to accommodate the largest font size in the row. Double-click on the right side of a column heading to 
automatically adjust the width of all cells in the column to accommodate the largest entry.

You can also set the size of a selected group of columns or rows to match the size of an existing row or 
column. First, select the group of rows or columns you want to resize, including the row or column whose 
size you want to match. Then, click the right border of the column header or the bottom border of the row 
whose size you want to match. The selected rows are resized to match the size of the row or column you 
clicked.

Changing Row Heights and Column Widths 



Fixing Rows and Columns 
Rows and columns in a worksheet can be fixed so that they do not scroll when you perform worksheet 
scrolling. Fixed rows remain stationary when you perform vertical scrolling; fixed columns remain 
stationary when you perform horizontal scrolling. Fixing rows and columns allows you to place titles in 
your worksheet that are always displayed, as shown in the following illustration.

Columns A and B in the are fixed in this worksheet. When horizontal scrolling is performed, columns A 
and B do not scroll.

When fixing rows and columns, you specify the starting row or column to fix and the number of rows or 
columns to fix. Rows and columns preceding the fixed area are not displayed in the worksheet. For 
example, if you fix rows 4 through 6, rows 1, 2, and 3 are not displayed.

To fix rows or columns:
1. Select the rows or columns you want to fix by clicking on the column or row header. To select 

multiple rows or columns, hold down SHIFT while you click.
2. Choose Fix Rows (or Columns) from the Sheet menu, depending on what you have selected.

Note      Data contained in fixed rows and columns cannot be edited. You must perform any data editing in 
these rows and columns prior to fixing. If you attempt to select a cell in a fixed row or column, the entire 
row or column is selected, as shown in the following illustration.





Setting Cell Borders and Colors
Cells and ranges can be formatted with borders, colors, and patterns.
Borders can be applied to the top, bottom, left, and right sides of a cell. You can select the type and color 
of line used for the border. When adding a border to a range, you can place a border around the outside 
of the range. 
When applying colors and patterns to a cell or range, you specify the pattern and foreground and 
background colors used to fill the cells.
To format cells:

1. Select the cells you want to format.
2. To change cell borders, choose Border from the Format menu to display the Borders dialog box. 

To change cell colors and patterns, choose Pattern from the Format menu to display the Pattern 
dialog box.



Formatting Row and Column Headings 
In addition to formatting worksheet cells, many aspects of row and column headings can be formatted. 
Worksheet headings contain three areas: the row headings, column headings, and the box in the top left 
corner of the worksheet where the row and column headings intersect. The following illustration highlights
these three areas.

Selecting Row and Column Heading Areas 
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Selecting Row and Column Heading      Areas
To select headings, press CTRL+SHIFT and click the heading area.

Formatting Row and Column Headings 
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Sizing Row and Column      Headings
To change the size of column headings, click and drag the bottom edge of the top left corner. 
To change the size of row headings, click and drag the right edge of the top left corner.
The following illustration shows interactive resizing of the column headings. Click on the pointer, guide, 
and resized worksheet for more information.

Formatting Row and Column Headings 
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When the pointer is placed on an edge of the top left corner, it appears as a double arrow.



A guide follows the pointer as you click and drag the header border. The guide indicates the placement of 
the header border when you release the mouse.



When you resize column headings, you also set the height of the top left corner. Likewise, when you 
resize row headings, you set the width of the top left corner.



Setting Row and Column      Text
Like other column and row header attributes, the text displayed in header cells can be changed.
To change the text for a row or column header:

1. Double-click on the header for which you want to enter text to display the Header Name dialog 
box.

2. Enter one or more lines of text to serve as the header name, as shown in the following illustration.

3. Click on the OK button.
The header text is displayed, as shown in the following illustration.

The row header area has been resized to display the new header text.

Formatting Row and Column Headings 



Reading and Writing      Files
SpreadPro can read and write a number of file formats. The following table lists the formats and the 
associated file name extensions.

Format Extension Description
Formula One 3 .VTS SpreadPro's native format. 
Excel 5 or 7 .XLS Excel 5.0 or 7.0 format. 
Excel 4.0 .XLS Excel 4.0 format.
Tabbed Text .TXT Tab-delimited text file including number formatting information.
Tabbed Text (Values Only) .TXT Tab-delimited text without formatting information.
HTML .HTM HTML format including text formatting . (Write-only format.)
HTML (Data Only) .HTM HTML format without graphics. (Write-only format.)

Since SpreadPro has some features not supported by Excel, files saved in the VTS file format cannot be 
read by Excel. The XLS format is based on records where each record represents a unique feature or 
property of the workbook.

If the file you save contains features not supported by Excel, they are removed when the workbook is 
saved as an XLS file. Likewise, Excel contains features not supported by SpreadPro. Unsupported 
features are ignored when SpreadPro loads an Excel worksheet or workbook. 

Important      If you load an Excel file that contains features not supported by SpreadPro, such as charts 
or function arrays, those features are ignored. If the imported file is then written from SpreadPro as an 
Excel file and subsequently read by Excel, those features are omitted and irretrievable.
SpreadPro cannot read password protected Excel files. If you intend to read files from Excel, they should 
not be password protected.



Writing out a Worksheet File in HTML      Format
SpreadPro users can save a worksheet in HTML format by selecting the Write item from the File Menu.
The Save File dialog then gives you the option of saving in two HTML formats: 

HTML - HTML format including data formatting, font and color information.
HTML (Data Only) - HTML format includes data formats, but excludes font and color information.



Working With    Objects
SpreadPro provides the ability to create objects in a worksheet. Among the objects you can create are 
charts, lines, rectangles, ovals, arcs, polygons, push buttons, check boxes, and drop down list boxes. As 
with other worksheet elements, SpreadPro provides a wide range of options for formatting and 
manipulating the appearance of objects you create.
Creating Objects 
Naming Objects 
Moving, Sizing, and Arranging Objects 
Formatting Objects 



Creating      Objects
SpreadPro provides several methods for creating objects in worksheets.

Objects to be created.
You can set the mode of the mouse to allow object drawing at any time.

Drawing Objects 
Naming Objects 
Formatting Objects 



Drawing      Objects
The Drawing toolbar contains buttons that allow you to create and edit objects. The following table 
describes the buttons on the toolbar.
Button Name Description

Worksheet tool Performs standard worksheet editing. Also selects objects for editing. Press CTRL when 
selecting buttons, check boxes, and drop down list boxes.

Polygon editing mode Toggles between normal polygon editing and polygon point editing. When 
polygon point editing is enabled, the points of a polygon can be moved.

Line tool Draws lines.

Rectangle tool Draws rectangles and squares.

Oval toolDraws ovals and circles.

Arc tool Draws arcs.

Polygon tool Draws polygons.

Button tool Draws push buttons.

Check box tool Draws check box objects.

List box tool Draws drop down list box objects.

Chart tool Charts the selected range of data.
Drawing objects is as simple as point, click, and drag.
To draw an object:

1. Select the tool for the object you want to draw.
The pointer appears as a small cross when positioned in the worksheet.

2. Position the pointer at the point where you want to begin drawing.
3. Click and drag to draw the object.

An outline of the object you are drawing appears and moves as you drag the mouse.
4. Release the mouse button to set the object.

Note      When drawing an object, press ALT to align the object to the cell grid.
Creating Objects 



Naming      Objects
Objects can be named after they are created. Object names do not take the place of object identification 
numbers. Rather, object names are used as a supplement to identification numbers, making it easier to 
track and manipulate objects.
To name an object:

1. Select the object you want to name.
2. Choose Name from the Object menu to display the Object Name dialog box.
3. In the entry field, enter the name to assign to the object.

Note      After an object is named, you must press CTRL to select it at run time.
Creating Objects 
Moving, Sizing, and Arranging Objects 
Formatting Objects 



Selecting      Objects
To select an object:

1. Position the pointer on the object you want to select.
The pointer appears as an arrow when positioned on an object.

2. Click the object.
When the object is selected, selection handles appear at the edges of the bounding box that 
surrounds the object.

Note      For check boxes, list boxes, and buttons that have been named you must press CTRL when 
selecting the object. In addition, in a worksheet at run time, you must press CTRL to select arcs, lines, 
ovals, polygons, and rectangles that have been named. 
To select multiple objects, press SHIFT as you select the objects. For objects that have been named, you 
must press CTRL+SHIFT to select multiple objects.
You can choose Select All from the Objects menu to select all the objects in a worksheet.
Selecting Check Box and List Box Items 



Moving, Sizing, and Arranging      Objects
After an object is created, you can change both the position and size of the object. 
Positioning Objects 
Arranging Overlapping Objects 
Arranging Objects and Object Order 



Positioning      Objects
To resize and reposition an object:

1. Select the object to be moved or sized.
Note      To select a named button, check box, or list box, you must press CTRL when selecting 
the object.
When you select an object, selection handles appear along the bounding box that surrounds the 
object. 

2. If moving the object, position the pointer anywhere in the area occupied by the object. If resizing 
the object, position the pointer on one of the selection handles.
When positioned in the object area, the pointer appears as an arrow. When positioned on a 
selection handle, the pointer appears as a two-headed arrow, indicating the direction in which the 
object can be resized.

3. Click and drag to move or resize the object.
An outline of the object moves with the pointer as you drag the mouse.
Note      When moving or resizing an object, you can align the object to the worksheet grid by 
pressing ALT as you click and drag.

4. Release the mouse to set the object at its new position or at its new size.
Moving, Sizing, and Arranging Objects 
Arranging Overlapping Objects 
Arranging Objects and Object Order 



Arranging Overlapping      Objects
When you have multiple objects on a worksheet, they appear to be drawn on the same plane. However, 
when two objects overlap, the previously drawn object is covered by the latter-drawn object. You can 
change the order of object layering in a worksheet by sending an object behind other objects or bringing 
an object to the front of other objects.
To arrange objects:

1. Select the object you want to move. 
2. Choose Bring to Front or Send to Back from the Object menu. The object is moved in the 

direction you specify.
Moving, Sizing, and Arranging Objects 
Positioning Objects 
Arranging Objects and Object Order 



Arranging Objects and Object      Order
When you use Bring To Front and Send To Back commands from the Object menu, you alter the order of 
the object list maintained by the worksheet. 
Moving, Sizing, and Arranging Objects 
Positioning Objects 
Arranging Overlapping Objects 



Formatting      Objects
Many elements of objects can be formatted including:

fill patterns and colors; line colors; and widths and styles for arcs, lines, ovals, polygons, and 
rectangles

the lists of items contained by drop down list boxes
the text displayed by check boxes or push buttons

Creating Objects 
Formatting Colors and Patterns 
Formatting List Boxes 
Formatting Check Boxes 
Formatting Buttons 
Selecting Check Box and List Box Items 
Setting Values 
Setting Values by Cell Reference 
Editing Polygons 



Formatting Colors and      Patterns
To set the fill colors and patterns for graphical objects – arcs, ovals, polygons, and rectangles – use the 
following methods:
To set fill colors and patterns for selected objects:

Choose Pattern from the Object menu. The Pattern dialog box is displayed from which you can 
make your pattern and color choices.
To format lines for selected objects:

Choose Line Style from the Object menu. The Line Style dialog box is displayed from which you 
can choose line attributes for the selected objects.
The following table shows the line styles that can be applied to line objects and the borders of arcs, ovals,
polygons, and rectangles:
Line styles
Solid
Dashed
Ditted
Dash-ditted
Dash-dit-ditted
None
Solid lines can be 1/2 point, 1 point, 2 points, or 3 points in weight. Styled lines can only be 1/2 point in 
weight.
Formatting Objects 
Formatting List Boxes 
Formatting Check Boxes 
Formatting Buttons 
Editing Polygons 



Formatting List      Boxes
List boxes can be formatted by setting or changing the cell they reference (whether a selection appears in
the referenced cell as a value or text) and specifying the list of selections in the list box.
To set or edit list box items:

1. Select a list box
2. Choose Options from the Object menu to display the Options dialog box.
3. Enter or edit the list of items contained by the list box. The items must be entered as a semicolon-

delimited list. 
The following illustration shows the Options dialog box. Click on the items for more information.

The following illustration shows a list box in a worksheet. 

Formatting Objects 
Formatting Check Boxes 
Formatting Buttons 
Selecting Check Box and List Box Items 
Setting Values 
Setting Values by Cell Reference 



Indicates the cell referenced by the list box.



Check this box to if you want numeric items in the list box to be text.



The items that appear in the list box are displayed as a semicolon-delimited list in the Options dialog box.



Formatting Check      Boxes
The text displayed by a check box can be set either through the Workbook Designer or programmatically.
To edit check box text:

1. Select a check box.
2. Choose Options from the Object menu to display the Options dialog box. In this dialog box, you 

can enter and edit the text displayed by the check box.
Formatting List Boxes 
Formatting Buttons 
Selecting Check Box and List Box Items 
Setting Values 
Setting Values by Cell Reference 



Formatting      Buttons
To edit button text:

1. Select a button.
2. Choose Options from the Object menu to display the Options dialog box. In this dialog box, you 

can enter and edit the text displayed on the button.
Formatting List Boxes 
Formatting Check Boxes 



Selecting Check Box and List Box      Items
SpreadPro provides a variety of methods for checking or unchecking check box objects and selecting 
items from drop down list box objects.

At run time, items can be checked or selected using the mouse.
By assigning a cell to an object, you can set the value in the cell by making a selection from the 

object. Likewise, if you enter a value that is in the list associated with a list box, you can change the value 
displayed in the list box. The cell reflects the value to which the object is set, regardless of the method 
used to set the value.

When you check or uncheck a check box, or select an item from list box, you set the value in the 
assigned cell. 

For a check box, the value of the assigned cell is True if the object is checked or False if 
unchecked. 

In a list box, you can choose to have the value of the assigned cell set to the number or the text 
of the selected item. Items in a list box are numbered consecutively, starting with 0 (e.g., the first item is 
item 0, the second item is item 1, and so on). -1 means that no item is selected in the list box.
Creating Objects 
Formatting List Boxes 
Formatting Check Boxes 
Setting Values 
Setting Values by Cell Reference 



Setting    Values
To set the value of a check box or list box, the object itself cannot be selected and the pointer must be in 
normal worksheet editing mode. 

To set the value of a check box, position the pointer anywhere in the check box area and click. 
The check box toggles between checked and unchecked states.

To set the value of a list box, position the pointer anywhere in the list box area and click. The list 
of items contained by the list box is displayed. If the list area is not large enough to display all the items, 
you may have to click the scroll areas to view the entire list. Then, click the item you want to select.
Formatting List Boxes 
Formatting Check Boxes 



Setting Values by Cell      Reference
For both check boxes and list boxes, you can specify a cell that references the object. The referenced cell
works in two ways:

If you select an item from the object, the value or text of that selection is displayed in the 
referenced cell. For example, if you uncheck a check box, FALSE is placed in the cell the check box 
references.

If you enter a valid value in the referenced cell, the current selection of the object reflects the cell 
value. For example, if you enter 0 in the cell, a list box that references the cell displays its first item as the 
current selection.
If multiple objects reference the same cell, making a selection in one object makes the same selection in 
all objects that reference the cell.
The cell reference for an object can be set in the Options dialog box, displayed by choosing Options from 
the Object menu when the object is selected. 
For list boxes only, you can specify whether the value or text of the selection is displayed in the cell.
Formatting List Boxes 
Formatting Check Boxes 



Editing      Polygons
When editing polygons, there are two editing modes:
Normal Polygon Editing. This mode allows you to resize and move polygons. Editing of polygon points 
is not allowed in this mode.
Polygon Point Editing. This mode allows you to reposition polygon points, thus changing the shape of 
the polygon. Use the polygon editing mode button in the toolbar to toggle between the polygon editing 
modes. The following illustration shows a selected polygon when normal polygon editing and polygon 
point editing modes are enabled. Click on the selection handles for more information.

To reshape a polygon:
1. Select the polygon to be reshaped.
2. Make certain that polygon editing mode is enabled.

When polygon editing mode is enabled, selection handles appear at each point along the border 
of the selected polygon.

3. Position the pointer on the polygon point that you want to move.
4. Click the point and drag the mouse.

An outline of the lines adjoining the point move as you drag the polygon point.
5. Release the mouse button to place the point at its new location.



When normal polygon editing mode is enabled, the selection handles appear at the 
edges of the bounding box that surrounds the polygon.
In this mode, the polygon can be resized and moved.



When polygon point editing mode is enabled, a selection handle appears at each point 
along the border of the polygon.
In this mode, the polygon points can be repositioned and the polygon can be moved.



Working with Chart      Objects
The following illustration shows an example of a chart on a worksheet.

To chart data:
1. Select a range of data to be charted.
2. Click the chart button in the Tool bar.
3. Draw a rectangle where you want to place the chart.

The Chart Wizard appears to assist you in designing the chart appearance.
4. Make any necessary selections from the Chart Wizard and click Finished.

Using the Chart Wizard 
Chart Options 
Referencing Data on Another Worksheet 



Using the Chart      Wizard
The tabs within the Chart Wizard guide you through most common design decisions required when you 
create or modify a chart. The Chart Wizard is displayed automatically when you draw a new chart on a 
worksheet. You can also display the Chart Wizard at any time to assist you in formatting an existing chart.
Important      Each chart type has individual requirements as to how the data must be laid out. Separate 
formatting options are also available for different chart types. You should read your First Impression 
User's Guide to familiarize yourself with the requirements of various chart types.
To access the Chart Wizard:

1. Double-click on the chart to activate it.
2. Right-click the chart to display the shortcut menu.
3. Choose Wizard from the menu.

The Chart Wizard provides four tabs that control various design aspects such as choosing a chart type, 
setting chart options, controlling chart layout, and specifying chart and axis titles. You can navigate 
through these tabs by clicking on the tab at the top of the dialog box, or by using the navigation buttons at
the bottom of the dialog box. 
Click on the following illustration to display additional information about the Chart Wizard.

Working with Chart Objects 



Using the Chart      Wizard
The tabs within the Chart Wizard guide you through most common design decisions required when you 
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The Chart Wizard provides four tabs that control various design aspects such as choosing a chart type, 
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Using the Chart      Wizard
The tabs within the Chart Wizard guide you through most common design decisions required when you 
create or modify a chart. The Chart Wizard is displayed automatically when you draw a new chart on a 
worksheet. You can also display the Chart Wizard at any time to assist you in formatting an existing chart.
Important      Each chart type has individual requirements as to how the data must be laid out. Separate 
formatting options are also available for different chart types. You should read your First Impression 
User's Guide to familiarize yourself with the requirements of various chart types.
To access the Chart Wizard:

1. Double-click on the chart to activate it.
2. Right-click the chart to display the shortcut menu.
3. Choose Wizard from the menu.

The Chart Wizard provides four tabs that control various design aspects such as choosing a chart type, 
setting chart options, controlling chart layout, and specifying chart and axis titles. You can navigate 
through these tabs by clicking on the tab at the top of the dialog box, or by using the navigation buttons at
the bottom of the dialog box.
Click on the following illustration to display additional information about the Chart Wizard.

Working with Chart Objects 



In the Gallery Tab, select the type of chart you wish to design. Two radio buttons control 
whether 2D chart or 3D chart types are displayed.



In the Style Tab, select a style for the chart type you have selected. Each style is a 
predefined set of display options such as series labels, stacking, and bar gap.



In the Layout Tab, specify an optional chart title, footnote, chart legend position, and whether the series 
data in the charted range should be charted along rows or columns. The chart preview image on this tab 
shows you how the chart will look with these modifications.



In the Axes Tab, enter optional axis titles for any or all axes on your chart. The chart preview image on 
this tab shows you how the chart will look with the addition of the axis title. 



Displays Wizard Help.



Aborts changes.



Displays previous tab.



Displays next tab.



Applies modifications.



Additional Chart Formatting
The Chart Wizard provides a quick and easy method for applying some of the most common formatting 
options to your chart. Additional formatting options are available by using the First Impression dialog 
boxes. These dialog boxes are displayed by double-clicking on chart elements in an activated chart 
object, or by selecting items from the First Impression shortcut menu. Consult your First Impression 
documentation for more information.
To access First Impression dialog boxes:

1. Double-click on the chart object to activate it.
2. Right-click on the chart to display the shortcut menu.
3. Make a selection from the menu.

Important      One of the options on the First Impression shortcut menu is Edit Chart Data. This displays 
First Impression's Data Grid View tool. In this tool you can modify the size and content of the chart's data 
source. Any changes you make in the Data Grid View tool are reflected in the chart, but are NOT reflected
in the worksheet. Also, if you use the Data Grid View tool to edit the chart data and then recalculate the 
workbook in SpreadPro while the chart still references a range in the worksheet, the worksheet data 
overwrites your changes. To prevent this, set the chart's formula to an empty string (" ") before using the 
Data Grid View tool to edit the data. 

Using the Chart Wizard 



Chart      Options
Within SpreadPro, you can control whether or not users can edit the chart and change the source data 
range for a chart using the Object Options dialog box.
To edit chart options:

1. Select the chart.
2. Choose Options from the Object menu to display the Object Options dialog box.

Uncheck the AllowUserChanges check box to prevent users from formatting the chart.
The Formula box lists the formula identifying the source data range for the chart.
Referencing Data on Another Worksheet 



Referencing Data on Another      Worksheet
You can also display a chart on one worksheet that references data on a separate worksheet.
To create a chart on a separate worksheet:

1. Select the chart tool.
2. Draw the chart on a worksheet.
3. Choose Options from the Object menu to display the Object Options dialog box.
4. Enter the formula referencing the data source on the other spreadsheet.

The worksheet shown in the following illustration provides summary information about inventory data 
stored on the worksheets named Region 1 and Region 2.

The cells B4 through D17 contain formulas that sum information from the worksheets Region 1 and 
Region 2.
The following worksheet displays the chart for the inventory data.



The data source formula for this chart object is Summary!A3:D17.
Chart Options 



Printing      Worksheets
To print the active sheet:

1. Choose Print from the File menu to display the Print dialog box.
2. Make any necessary adjustments to the settings and click OK.

Specifying Print Areas 
Specifying Row and Column Print Titles 
Specifying Headers and Footers 
Specifying Page Breaks 
Setting Printing Orientation 



Specifying Print      Areas
SpreadPro prints the entire active worksheet unless you specify the ranges you want to print. To specify 
the areas you want to print, you must set the Print_Area name to reflect the worksheet area to be printed.
To set the print area:

1. Select the ranges to print.
2. Choose Set Print Area on the Sheet menu.

Specifying Row and Column Print Titles 
Specifying Headers and Footers 
Specifying Page Breaks 



Specifying Row and Column Print      Titles
You can specify row or column titles that you want printed on each page of your worksheet. If you select a
row, it is printed at the top of each page. If you select a column, it is printed at the left edge of each page. 
You can select multiple rows or columns, but they must be adjacent.
Important      When setting print titles, you must select entire rows and columns.
The Print_Titles name holds the row and column titles specification. 
To set print titles:

1. Select the rows or columns to use as print titles.
2. Choose Print Titles on the Sheet menu.

Specifying Print Areas 
Specifying Headers and Footers 
Specifying Page Breaks 



Specifying Headers and      Footers
Headers and footers are printed at the top and bottom of each page. The header and footer definition is 
accessible in the Page Setup dialog box. 

Headers and footers can contain text and special formatting codes. The following table lists the special 
formatting codes. Header and footer codes can be entered in upper or lower case.
Format Code Description
&L Left-aligns the characters that follow.
&C Centers the characters that follow.
&R Right-aligns the characters that follow.
&D Prints the current date.
&T Prints the current time.
&F Prints the workbook name.
&A Prints the worksheet name.
&P Prints the page number.
&P+number Prints the page number plus number.
&P-number Prints the page number minus number.
&& Prints an ampersand.
&N Prints the total number of pages in the document.
Codes and text are, by default, centered unless &L or &R is specified.
The following font codes must appear before other codes and text or they are ignored. The alignment 
codes (e.g., &L, &C, and &R) restart each section; new font codes can be specified after an alignment 
code.
Format Code Description
&B Use a bold font.
&I Use an italic font.
&U Underline the header.
&S Strikeout the header.
&O Ignored.
&H Ignored.
&"fontname" Use the specified font.
&nn Use the specified font size - must be a two digit number.
Specifying Print Areas 
Specifying Row and Column Print Titles 
Specifying Page Breaks 



Specifying Page Breaks
Both horizontal and vertical page breaks can be specified on a worksheet. 
Page breaks are always placed adjacent to the active cell. When using methods, page breaks can be 
placed adjacent to the active cell or a cell that you specify.

Horizontal (row) page breaks are placed adjacent to the top edge of the active or specified cell.
Vertical (column) page breaks are placed adjacent to the left edge of the active or specified cell.

To set page breaks:
1. Select the cell adjacent to which you want to place page breaks.
2. Choose Set Page Breaks from the Sheet menu.



Setting Printing      Orientation
Worksheet pages can be printed with a portrait or landscape orientation. 
To set printing orientation:

Choose Print Setup from the File menu and set the printing orientation in the Print Setup dialog 
box.



Previewing Worksheets Before Printing      
Select Print Preview from the File menu, a preview of the printed pages will then be displayed.



 Specifications
The following table lists the technical specifications for SpreadPro.
Specifications
Maximum worksheet size 16,384 Rows by 256 Columns
Column width 0 to 255 characters
Row height 0 to 409 points
Text length 255 characters
Formula length 1024 characters
Number precision 15 digits
Largest positive number 9.99999999999999E307
Largest negative number -9.99999999999999E307
Smallest positive number 1E-307
Smallest negative number -1E-307
Maximum number of iterations 32,767
Maximum number of colors 56
Maximum number of available colors Limited by display card and monitor
Maximum number of fonts per sheet 256
Maximum number of selected ranges 2048
Maximum number of names per sheet 16384
Maximum length of name 255
Maximum number of function arguments 30
Maximum length of format string 255
Maximum number of tables Limited by system resources (Windows and memory)
Excel file format version Excel 4.0, 5.0, and 7.0



Main      Toolbar
The buttons on the Main Toolbar provide easy access to some of the most common SpreadPro menu 
items. Click on a button for more information.



File    Menu
Items on the File menu allow you to create new files, open existing files, save files, preview and print files,
and modify your page and print setup settings. Click on a menu item for more information.



Edit      Menu
The items on the Edit menu allow you to cut, copy, paste, and clear data; insert and delete cells; and go 
to a specific location in the worksheet. Click on a menu item for more information.



View      Menu
Items on the View menu allow you to toggle the display of various tool bars and control basic formatting 
information for the workbook. Click on a menu item for more information.



Data      Menu
The items on the Data menu allow you to control worksheet calculation, create defined names, sort data, 
and create autofill lists. Click on a menu item for more information.



Format      Menu
Items on the Format menu allow you to format worksheet elements. Click on a menu item for more 
information.



Object      Menu
The items on the Object menu allow you to format and manipulate objects on a worksheet. Click on an 
item for more information.



Help      Menu
The items on the Help menu provide information about SpreadPro.



Select Using Help to display general Windows help information.



 ABS
Description
Returns the absolute value of a number. 
Syntax

ABS ( number )
Parameter Description
number Any number.
Remarks
An absolute value does not display a positive or negative sign.
Examples
These functions both return 1:

ABS(–1)
ABS(1)



 ACOS
Description
Returns the arc cosine of a number. 
Syntax

ACOS ( number )
Parameter Description
number The cosine of the angle. The cosine can range from 1 to -1.
Remarks
The resulting angle is returned in radians (from 0 to p). To convert the resulting radians to degrees, 
multiply the radians by 180/PI( ).
Examples
This function returns 1.05:

ACOS(.5)
This function returns 1.77:

ACOS(–.2)
See Also

COS 



 ACOSH
Description
Returns the inverse hyperbolic cosine of a number.
Syntax

ACOSH ( number )
Parameter Description
number Any number equal to or greater than 1.
Examples
This function returns .62:

ACOSH(1.2)
This function returns 1.76:

ACOSH (3)
See Also

ASINH 
ATANH 
COSH 



 ASC
Description
Returns a copy of text in which the double-byte characters (if any) have been converted to single-byte. 
Any double-byte characters that do not have single-byte equivalents are left in their original form.
Syntax

ASC (text)
Parameter Description
text The text containing double-byte characters which is converted to single-byte.
See Also

DBCS



 ADDRESS
Description
Creates a cell address as text.
Syntax

ADDRESS ( row, column, ref_type [, a1] [, sheet] )
Parameter Description
row The row number for the cell address.
column The column number for the cell address.
ref_type The cell reference type. Following are the valid values for this argument.

Value Description
1 Absolute
2 Absolute row, relative column
3 Relative row, absolute column
4 Relative

a1 The reference format. This argument must be TRUE( ) to represent an A1 reference format; SpreadPro does
not support the R1C1 reference format.
sheet The name of an external worksheet view control. Omitting this argument assumes that the reference exists 
in the current spreadsheet.
Examples
This function returns $F$5:

ADDRESS(5, 6, 1)
This function returns SALES!F5:

ADDRESS(5, 6, 4, TRUE(), "SALES.")
See Also

COLUMN 
OFFSET 
ROW 



 AND
Description
Returns True if all arguments are true; returns False if at least one argument is false.
Syntax

AND ( logical_list )
Parameter Description
logical_list A list of conditions separated by commas. You can include as many as 30 conditions in the list. The
list can contain logical values or a reference to a range containing logical values. Text and empty cells are ignored. If 
there are no logical values in the list, the error #VALUE! is returned.
Examples
This function returns True because both arguments are true:

AND(1+1=2, 5+5=10)
This function returns False:

AND(TRUE(), FALSE()) 
See Also

NOT 
OR 
ROW 



 ASIN
Description
Returns the arcsine of a number. 
Syntax

ASIN ( number )
Parameter Description
number The sine of the resulting angle, ranging from -1 to 1.
Remarks
The resulting angle is returned in radians (ranging from -pi/2 to pi/2). To convert the resulting radians to 
degrees, multiply the radians by 180/pi().
Examples
This function returns –1.57:

ASIN(–1) 
This function returns .41:

ASIN(.4)
See Also

ASINH 
PI 
SIN 



 ASINH
Description
Returns the inverse hyperbolic sine of a number.
Syntax

ASINH ( number )
Parameter Description
number Any number.
Examples
This function returns 2.37:

ASINH(5.3)
This function returns -2.09:

ASINH(-4)
See Also

ACOSH 
ASIN 
ATANH 
SINH 



 ATAN
Description
Returns the arctangent of a number. 
Syntax

ATAN ( number )
Parameter Description
number The tangent of the angle.
Remarks
The resulting angle is returned in radians, ranging from -pi/2 to pi/2. To convert the resulting radians to 
degrees, multiply the radians by 180/pi( ).
Examples
This function returns 1.29:

ATAN(3.5)
This function returns -1.33:

ATAN(–4)
See Also

ATAN2 
ATANH 
PI 
TAN 



 ATAN2
Description
Returns the arctangent of the specified coordinates. 
Syntax

ATAN2 ( x, y )
Parameter Description
 x The x coordinate.
y The y coordinate.
Remarks
The arctangent is the angle from the x axis to a line with end points at the origin (0, 0) and a point with the
given coordinates (x, y). The angle is returned in radians, ranging from -pi to pi, excluding -pi.
Examples
This function returns 1.11:

ATAN2(3, 6)
This function returns 3.04:

ATAN2(–1, .1)
See Also

ATAN 
ATANH 
PI 
TAN 



 ATANH
Description
Returns the inverse hyperbolic tangent of a number.
Syntax

ATANH ( number )
Parameter Description
number A number between -1 and 1, excluding -1 and 1.
Examples
This function returns .55:

ATANH(.5)
This function returns -.26:

ATANH(–.25)
See Also

ACOS 
ASINH 
TANH 



 AVERAGE
Description
Returns the average of the supplied numbers. The result of AVERAGE is also known as the arithmetic 
mean.
Syntax

AVERAGE ( number_list )
Parameter Description
number_list A list of numbers separated by commas. As many as 30 numbers can be included in the list, and 
the list can contain numbers or a reference to a range that contains numbers. Text, logical expressions, or empty cells
in a referenced range are ignored. All numeric values (including 0) are used.
Examples
This function returns 8.25:

AVERAGE(5, 6, 8, 14)
This function returns 134, the average of the values in the range C15:C17:

AVERAGE(C15:C17) 
See Also

MAX 
MIN 



 CALL
Description
Calls a procedure in a dynamic link library. There are two syntax forms of this function. When CALL is 
used with REGISTER.ID, as shown in syntax 1, the DLL is loaded and remains loaded until the program 
is dismissed. When CALL is used alone, as shown in syntax 2, the DLL is loaded, the function is called, 
and then the DLL is unloaded.
Important      This function is provided for advanced users only. If you use the CALL function incorrectly, 
you could cause errors that will require you to restart your computer.
Syntax 1
Used with REGISTER.ID

CALL(register_id, argument1, ...)
Syntax 2
Used alone

CALL(module_text, procedure, type_text, argument1, ...)
Parameter Description
register_id The value returned by a previously executed REGISTER.ID function.
argument1 The arguments to be passed to the procedure.
module_text Quoted text or reference specifying the name of the dynamic link library (DLL) that contains the 
procedure.
procedure Text specifying the name of the function in the DLL in SpreadPro. The function name is case 
dependent in 32-bit SpreadPro.
type_text Text specifying the data type of the return value and the data types of all arguments to the DLL or 
code resource. The first letter of type_text specifies the return value. The data types you use for type_text are 
described in the following table.

Data Type Description Pass by C Declaration
A Logical (False = 0, True = 1) Value short int
B IEEE 8-byte floating point number Value double
C Null-terminated string (255 characters maximum) Reference char *
D Byte-counted string (first byte contains string length; 255 characters maximum) Reference
unsigned char *
E IEEE 8-byte floating point number Reference double *
F Null-terminated string (255 characters maximum) Reference char *
G Byte-counted string (first byte contains string length; 255 characters maximum) Reference
unsigned char *
H Unsigned 2-byte integer Value unsigned short int
I Signed 2-byte integer Value short int
J Signed 4-byte integer Value long int
L Logical (False = 0, True = 1) Reference short int *
M Signed 2-byte integer Reference short int *
N Signed 4-byte integer Reference long int *

Remarks
For declarations made in C, it is assumed that your compiler defaults to 8-byte doubles, 2-byte short 
integers, and 4-byte long integers. In the Windows programming environment, all pointers should be far 
pointers.
Pascal calling conventions are used for all functions called from DLLs. For most C compilers, you must 
add the –Pascal keyword to the function declaration.
If the return value for your custom function uses a pass-by-reference data type, a null pointer can be 
passed as the return value. The null pointer is interpreted as the #NUM! error value.
For the F and G data types, a custom function can modify an allocated string buffer. If the return value 
type code is F or G, the value returned by the function is ignored. The list of function arguments is 
searched for the first data type that corresponds to the return value type. The current contents of the 
allocated string buffer is taken for the return value. 256 bytes is allocated for the argument; therefore, a 
function can return a larger string than it receives.
You can use a single digit (n), with a value from 1 to 9, as the code for data_type. The variable in the 
location pointed to by the nth argument is modified instead of the return value; this process is referred to 
as modifying in place. The nth argument must be a pass-by-reference data type. In addition, you must 
declare the function void. For most C compilers, you can add the Void keyword to the function 
declaration.



Examples
Syntax 1 (32-bit SpreadPro) 
In 32-bit SpreadPro, the following macro formula registers the GetTickCount function from 32-bit Microsoft
Windows. GetTickCount returns the number of milliseconds that have elapsed since Microsoft Windows 
was started.

REGISTER.ID("Kernel32","GetTickCount","J") 
Assuming that this REGISTER.ID function is in cell A5, after your macro registers GetTickCount, you can 
use the CALL function to return the number of milliseconds that have elapsed since Windows was 
started: 

CALL(A5)
Syntax 1 (16-bit SpreadPro)
In 16-bit SpreadPro, the following macro formula registers the GetTickCount function from 16-bit Microsoft
Windows. GetTickCount returns the number of milliseconds that have elapsed since Microsoft Windows 
was started.

REGISTER.ID("User","GetTickCount","J")
Assuming that this REGISTER.ID function is in cell A5, after your macro registers GetTickCount, you can 
use the CALL function to return the number of milliseconds that have elapsed:

CALL(A5)
Syntax 2 (32-bit SpreadPro)
On a worksheet, you can use the following CALL formula (syntax 2) to call the GetTickCount function:

CALL("Kernel32","GetTickCount","J!")
or
Syntax 2 (16-bit SpreadPro)
On a worksheet, you can use the following CALL formula (syntax 2) to call the GetTickCount function:

CALL("User","GetTickCount","J!")
The ! in the type_text argument forces SpreadPro to recalculate the CALL function every time the 
worksheet recalculates. This updates the elapsed time whenever the worksheet recalculates.



 CEILING
Description
Rounds a number up to the nearest multiple of a specified significance. 
Syntax

CEILING ( number, significance )
Parameter Description
number The value to round.
significance The multiple to which to round.
Remarks
Regardless of the sign of the number, the value is rounded up, away from zero. If number is an exact 
multiple of significance, no rounding occurs.
If the number or significance is non-numeric, the error #VALUE! is returned. When the arguments have 
opposite signs, the error #NUM! is returned.
Examples
This function returns 1.25:

CEILING(1.23459, .05)
This function returns –150:

CEILING(–148.24, –2) 
See Also

EVEN 
FLOOR 
INT 
ODD 
ROUND 
TRUNC 



 CHAR
Description
Returns a character that corresponds to the supplied ASCII code. 
Syntax

CHAR ( number )
Parameter Description
number A value between 1 and 255 that specifies an ASCII character.
Remarks
The character and associated numeric code are defined by Windows in the ASCII character set.
Examples
This function returns F:

CHAR(70)
This function returns #:

CHAR(35)
See Also

CODE 



 CHOOSE
Description
Returns a value from a list of numbers based on the index number supplied.
Syntax

CHOOSE ( index, item_list )
Parameter Description
index A number that refers to an item in item_list.
item_list A list of numbers, formulas, or text separated by commas. This argument can also be a range reference. You
can specify as many as 29 items in the list.
Remarks
index can be a cell reference; index can also be a formula that returns any value from 1 to 29. If index is 
less than 1 or greater than the number of items in item_list, #VALUE! is returned. If index is a fractional 
number, it is truncated to an integer.
Examples
This function returns Q2:

CHOOSE(2,"Q1", "Q2", "Q3", "Q4")
This function returns the average of the contents of range A1:A10:

AVERAGE(CHOOSE(1, A1:A10, B1:B10, C1:C10))
See Also

INDEX 



 CLEAN
Description
Removes all nonprintable characters from the supplied text. 
Syntax

CLEAN ( text )
Parameter Description
text Any worksheet information.
Remarks
Text that is imported from another environment may require this function.
Examples
This function returns Payments Due because the character returned by CHAR (8) is nonprintable:

CLEAN("Payments " & CHAR(8) & "Due")
See Also

CHAR 
TRIM 



 CODE
Description
Returns a numeric code representing the first character of the supplied string.
Syntax

CODE ( text )
Parameter Description
text Any string.
Remarks
The numeric code and associated string are defined in your computer's character set. The character set 
used by Windows is the ANSI character set.
Examples
This function returns 65:

CODE("A")
This function returns 98:

CODE("b")
See Also

CHAR 



 COLUMN
Description
Returns the column number of the supplied reference. 
Syntax

COLUMN ( reference )
Parameter Description
reference A reference to a cell or range. Omitting the argument returns the number of the column in which 
COLUMN is placed.
Examples
This function returns 2:

COLUMN(B3) 
This function returns 4 if the function is entered in cell D2:

COLUMN() 
See Also

COLUMNS 
ROW 



 COLUMNS
Description
Returns the number of columns in a range reference.
Syntax

COLUMNS ( range )
Parameter Description
range A reference to a range of cells.
Example
This function returns 4:

COLUMNS(A1:D5)
See Also

COLUMN 
ROWS 



 CONCATENATE
Description
Joins several text strings into one string.
Syntax

CONCATENATE ( text1, text2, .... )
Parameter Description
text1, text2, ... Up to 30 text items to be joined into a single text item. The text items can be strings, numbers, or 
single-cell references.
Remarks
The "&" operator can be used instead of CONCATENATE to join text items.
Examples
The following example returns "Sale Price" it is the same as typing "Sale"&" "&"Price":

CONCATENATE ("Sale ", "Price")
Suppose in an inventory worksheet, C2 contains "extruder1", C5 contains " gaskets", and C8 contains the
number 15. The following example returns "Inventory currently holds 15 gaskets for extruder1":

CONCATENATE ("Inventory currently holds ", C8, " ", C5," for ", C2)
See Also

COLUMN 
ROWS 



 COS
Description
Returns the cosine of an angle.
Syntax

COS ( number )
Parameter Description
number The angle in radians. If the angle is in degrees, convert the angle to radians by multiplying the angle by 
PI()/180.
Examples
This function returns .126:

COS(1.444)
This function returns .28:

COS(5) 
See Also

ACOS 
ASINH 
ATANH 
COSH 
PI 



 COSH
Description
Returns the hyperbolic cosine of a number.
Syntax

COSH ( number )
Parameter Description
number Any number.
Examples
This function returns 4.14:

COSH(2.10)
This function returns 1.03:

COSH(.24)
See Also

ASINH 
ATANH 
COS 



 COUNT
Description
Returns the number of values in the supplied list.
Syntax

COUNT ( value_list )
Parameter Description
value_list A list of values. The list can contain as many as 30 values.
Remarks
COUNT only numerates numbers or numerical values such as logical values, dates, or text 
representations of dates. If you supply a range, only numbers and numerical values in the range are 
counted. Empty cells, logical values, text, and error values in the range are ignored.
Examples
This function returns 2:

COUNT(5, 6, "Q2")
This function returns 3:

COUNT("03/06/94", "06/21/94", "10/19/94")
See Also

AVERAGE 
COUNTA 
SUM 



 COUNTIF
Description
Returns the number of cells within a range which meet the given criteria.
Syntax

COUNTIF ( range, criteria )
Parameter Description
range Range of cells you want to count.
criteria Number, expression, or text that defines which cells are counted.
See Also

AVERAGE 
COUNTA 
SUM 
SUMIF 



 COUNTA
Description
Returns the number of nonblank values in the supplied list. 
Syntax

COUNTA ( expression_list )
Parameter Description
expression_list A list of expressions. As many as 30 expressions can be included in the list.
Remarks
COUNTA returns the number of cells that contain data in a range. Null values (" ") are counted, but 
references to empty cells are ignored.
Examples
This function returns 4:

COUNTA(32, 45, "Earnings", "")
This function returns 0 when the specified range contains empty cells:

COUNTA(C38:C40)
See Also

AVERAGE 
COUNT 
PRODUCT 
SUM 



 DATE
Description
Returns the serial number of the supplied date.
Syntax

DATE ( year, month, day )
Parameter Description
year A number from 1900 to 2078. If year is between 1920 to 2019, you can specify two digits to represent the 
year; otherwise specify all four digits.
month A number representing the month (for example, 12 represents December). If a number greater than 12 is 
supplied, the number is added to the first month of the specified year.
day A number representing the day of the month. If the number you specify for day exceeds the number of days 
in that month, the number is added to the first day of the specified month.
Examples
This function returns 34506:

DATE(94, 6, 21)
This function returns 36225:

DATE(99, 3, 6)
See Also

DATEVALUE 
DAY 
MONTH 
NOW 
TIMEVALUE 
TODAY 
YEAR 



 DATEVALUE
Description
Returns the serial number of a date supplied as a text string.
Syntax

DATEVALUE ( text )
Parameter Description
text A date in text format between January 1, 1900, and December 31, 2078. If you omit the year, the current 
year is used.
Examples
This function returns 34399:

DATEVALUE("3/6/94")
This function returns 35058:

DATEVALUE("12/25/95")
See Also

NOW 
TIMEVALUE 
TODAY 



 DAY
Description
Returns the day of the month that corresponds to the date represented by the supplied number.
Syntax

DAY ( serial_number )
Parameter Description
serial_number A date represented as a serial number or as text (for example, 06-21-94 or 21-Jun-94).
Examples
This function returns 6:

DAY(34399)
This function returns 21:

DAY("06-21-94")
See Also

HOUR 
MINUTE 
MONTH
NOW 
SECOND 
TODAY 
WEEKDAY 
YEAR 



DAYS360
Description
Returns the number of days between two dates based on a 360-day year (twelve 30-day months). Use 
this function to help compute payments if your accounting system is based on twelve 30-day months.
Syntax

DAYS360 (start_date, end_date, [  ] )
Parameter Description
start_date, end_date The two dates between which you want to know the number of days.
method A logical value that specifies whether the European or US method should be used in the calculation. If False 
(or omitted), the US (NASD) method is used. If True, the European method is used. The default is based on the local 
translation. It should be correct for your location.
Remarks
start_date and end_date can be text strings using numbers to represent the month, day, and year (for 
example, "1/30/93" or "1-30-93"), or they can be serial numbers representing the dates.
If start_date occurs after end_date, DAYS360 returns a negative number.
If method is set to False and start_date is the 31st of a month, it becomes equal to the 30th of the same 
month. If end_date is the 31st of a month and start_date is less than the 30th of a month, the ending date 
becomes equal to the 1st of the next month, otherwise the ending date becomes equal to the 30th of the 
same month.
If method is set to True, start_dates or end_dates which occur on the 31st of a month become equal to 
the 30th of the same month.
Note To determine the number of days between two dates in a normal year, you can use normal 
subtraction--for example, "12/31/93"-"1/1/93" equals 364.
Example

DAYS360("1/30/93", "2/1/93") equals 1



 DB
Description
Returns the real depreciation of an asset for a specific period of time using the fixed-declining balance 
method.
Syntax

DB ( cost, salvage, life, period [, months] )
Parameter Description
cost The initial cost of the asset.
salvage The salvage value of the asset.
life The number of periods in the useful life of the asset.
period The period for which to calculate the depreciation. The time units used to determine period and life must 
match.
months The number of months in the first year of the item's life. Omitting this argument assumes there are 12 
months in the first year.
Example
This function returns 1451.52:

DB(10000, 1000, 7, 3)
See Also

DDB 
SLN 
SYD 
VDB 



 DBCS
Description
Returns a copy of text in which the single-byte characters (if any) have been converted to double-byte 
characters. Any single-byte characters that do not have double-byte equivalents are left in their original 
(single-byte) form.
Syntax

DBCS 
Parameter Description
text The text containing single-byte characters which is converted to double-byte characters.
See Also
ASC



 DDB
Description
Returns the depreciation of an asset for a specific period of time using the double-declining balance 
method or a declining balance factor you supply.
Syntax

DDB ( cost, salvage, life, period [, factor] )
Parameter Description
cost The initial cost of the asset.
salvage The salvage value of the asset.
life The number of periods in the useful life of the asset.
period The period for which to calculate the depreciation. The time units used to determine period and life must 
match.
factor The rate at which the balance declines. Omitting this argument assumes a default factor of 2, the double-
declining balance factor.
Remarks
The double-declining balance method uses an accelerated rate where the highest depreciation occurs in 
the first period, decreasing in successive periods.
All arguments for this function must be positive numbers.
Example
This function returns 1457.73:

DDB(10000,1000, 7, 3)
See Also

DB 
SLN 
SYD 
VDB 



 DOLLAR
Description
Returns the specified number as text, using currency format and the supplied precision.
Syntax

DOLLAR ( number [, precision] )
Parameter Description
number A number, a formula that evaluates to a number, or a reference to a cell that contains a number.
precision A value representing the number of decimal places to the right of the decimal point. Omitting this 
argument assumes the standard number of decimal places for the local currency.
Note
"Local" currency refers to the currency format for the current system, i.e., the one specified in Regional 
Settings in Control Panel
Remarks
Dollar will return the specified number format as text using currency format for the current system. If you 
wish to always convert to the USDollar format, regardless of the language of your system, then use the 
USDOLLAR worksheet function. 
Examples
This function returns $1023.79:

DOLLAR(1023.789)
This function returns $500:

DOLLAR(495.301, –2)
See Also

FIXED 
TEXT 
VALUE 



 ERROR.TYPE
Description
Returns a number corresponding to an error.
Syntax

ERROR.TYPE ( error_ref )
Parameter Description
error_ref A cell reference. 
Remarks
The following error text or numbers can be returned by this function.
Number Description
1 #NULL!
2 #DIV/0!
3 #VALUE!
4 #REF!
5 #NAME?
6 #NUM!
7 #N/A
#N/A Other
Example
This function returns 2 if the formula in cell A1 attempts to divide by zero:

ERROR.TYPE(A1) 
See Also

ISERR 
ISERROR 



 EVEN
Description
Rounds the specified number up to the nearest even integer.
Syntax

EVEN ( number )
Parameter Description
number Any number, a formula that evaluates to a number, or a reference to a cell that contains a number.
Examples
This function returns 4:

EVEN(2.5)
This function returns 2032:

EVEN(2030.45)
See Also

CEILING 
FLOOR 
INT 
ODD 
ROUND 
TRUNC 



 EXACT
Description
Compares two expressions for identical, case-sensitive matches. True is returned if the expressions are 
identical; False is returned if they are not.
Syntax

EXACT ( expression1, expression2 )
Parameter Description
expression1 Any text.
expression2 Any text.
Examples
This function returns True:

EXACT("Match", "Match")
This function returns False:

EXACT("Match", "match")
See Also

LEN 
SEARCH 



 EXP
Description
Returns e raised to the specified power. The constant e is 2.71828182845904 (the base of the natural 
logarithm). 
Syntax

EXP ( number )
Parameter Description
number Any number as the exponent.
Examples
This function returns 12.18:

EXP(2.5)
This function returns 20.09:

EXP(3)
See Also

LN 
LOG 



 FACT
Description
Returns the factorial of a specified number.
Syntax

FACT ( number )
Parameter Description
number Any non-negative integer. If you supply a real number, FACT truncates the number to an integer before 
calculation.
Examples
This function returns 2:

FACT(2.5)
This function returns 720:

FACT(6)
See Also

PRODUCT 



 FALSE
Description
Returns the logical value False. This function always requires the trailing parentheses.
Syntax

FALSE ( )
See Also

TRUE 



 FIND
Description
Searches for a string of text within another text string and returns the character position at which the 
search string first occurs.
Syntax

FIND ( search_text, text [, start_position] )
Parameter Description
search_text The text to find. If you specify an empty string (" "), FIND matches the first character in text.
text The text to be searched.
start_position The character position in text where the search begins. The first character in text is character 
number 1. When you omit this argument, the default starting position is character number 1.
Remarks
FIND is case-sensitive. You cannot use wildcard characters in the search_text.
Examples
This function returns 12:

FIND("time", "There's no time like the present")
This function returns 19:

FIND("4", "Aisle 4, Part 123-4-11", 9)
See Also

EXACT 
LEN 
MID 
SEARCH 



 FINDB
Description
Searches for a string of text within another text string and returns the byte position at which the search 
string first occurs.
Syntax

FINDB ( search_text, text [, start_position] )
Parameter Description
search_text The text to find. If you specify an empty string (" "), FINDB matches the first byte in text.
text The text to be searched.
start_position The byte position in text where the search begins. The first byte in text is byte number 1. When you
omit this argument, the default starting position is byte number 1.
Remarks
FINDB is case-sensitive. You cannot use wildcard characters in the search_text.
Examples
This function returns 12:

FINDB("time", "There's no time like the present")
This function returns 19:

FINDB("4", "Aisle 4, Part 123-4-11", 9)



 FIXED
Description
Rounds a number to the supplied precision, formats the number in decimal format, and returns the result 
as text.
Syntax

FIXED ( number [, precision][, no_commas] )
Parameter Description
number Any number.
precision The number of digits that appear to the right of the decimal place. When this argument is omitted, a
default precision of 2 is used. If you specify negative precision, number is rounded to the left of the decimal point. You
can specify a precision as great as 127 digits.
no_commas Determines if thousands separators (commas) are used in the result. Use 1 to exclude commas in 
the result. If no_commas is 0 or the argument is omitted, thousands separators are included (for example, 1,000.00).
Examples
This function returns 2,000.500:

FIXED(2000.5, 3)
This function returns 2010:

FIXED(2009.5, –1, 1)
See Also

DOLLAR 
ROUND 
TEXT 
VALUE 



 FLOOR
Description
Rounds a number down to the nearest multiple of a specified significance. 
Syntax

FLOOR ( number, significance )
Parameter Description
number The value to round.
significance The multiple to which to round.
Remarks
Regardless of the sign of the number, the value is rounded down, toward zero. If number is an exact 
multiple of significance, no rounding occurs.
If number or significance is non-numeric, #NAME? is returned. When the arguments have opposite signs, 
#NUM! is returned.
Examples
This function returns 1.2:

FLOOR(1.23459, .05)
This function returns –148:

FLOOR(–148.24, –2)
See Also

CEILING 
EVEN 
INT 
ODD 
ROUND 
TRUNC 



 FV
Description
Returns the future value of an annuity based on regular payments and a fixed interest rate. 
Syntax

FV ( interest, nper, payment [, pv] [, type] )
Parameter Description
interest The fixed interest rate.
nper The number of payments in an annuity.
payment The fixed payment made each period.
pv The present value, or the lump sum amount, the annuity is currently worth. When you omit this argument, a 
present value of 0 is assumed.
type Indicates when payments are due. Use 0 if payments are due at the end of the period or 1 if payments are 
due at the beginning of the period. When you omit this argument, 0 is assumed.
Remarks
The units used for interest must match those used for nper. For example, if the annuity has an 8 percent 
annual interest rate over a period of 5 years, specify 8 percent/12 for interest and 5*12 for nper.
Cash paid out, such as a payment, is shown as a negative number. Cash received, such as a dividend 
check, is shown as a positive number.
Examples
This function returns 4,774.55:

FV(5%, 8, –500)
This function returns 531,550.86:

FV(10%/12, 240, –700, 1)
See Also

IPMT 
NPER 
PMT 
PPMT 
PV 
RATE 



 HLOOKUP
Description
Searches the top row of a table for a value and returns the contents of a cell in that table that corresponds
to the location of the search value. 
Syntax

HLOOKUP ( search_item, search_range, row_index )
Parameter Description
search_item A value, text string, or reference to a cell containing a value that is matched against data in the top 
row of search_range.
search_range A reference to the range (table) to be searched. The cells in the first row of search_range can 
contain numbers, text, or logical values. The contents of the first row must be in ascending order (for example, –2, –1,
0, 2…, A through Z, False, True). Text searches are not case-sensitive.
row_index The row in search_range from which the matching value is returned. row_index can be a number 
from 1 to the number of rows in search_range. If row_index is less than 1, the error #VALUE! is returned. When 
row_index is greater than the number of rows in the table, the error #REF! is returned.
Remarks
HLOOKUP compares the information in the top row of search_range to the supplied search_item. When 
a match is found, information located in the same column and supplied row (row_index) is returned.
If search_item cannot be found in the top row of search_range, the largest value that is less than 
search_item is used. When search_item is less than the smallest value in the first row of the 
search_range, the error #REF! is returned.
Examples
The following examples use this worksheet.

This function returns 22.63:
HLOOKUP("Northeast", B1:E5, 3)

This function returns #REF!:
HLOOKUP("Pacific", B1:E5, 7)

See Also
INDEX 
LOOKUP 
MATCH 
VLOOKUP 



 HOUR
Description
Returns the hour component of the specified time in 24-hour format.
Syntax

HOUR ( serial_number )
Parameter Description
serial_number The time as a serial number. The decimal portion of the number represents time as a fraction of the
day.
Remarks
The result is an integer ranging from 0 (12:00 AM) to 23 (11:00 PM).
Examples
This function returns 9:

HOUR(34259.4)
This function returns 23:

HOUR(34619.976)
See Also

DAY 
MINUTE 
MONTH 
NOW 
SECOND 
WEEKDAY 
YEAR 



 IF
Description
Tests the condition and returns the specified value.
Syntax

IF ( condition, true_value, false_value )
Parameter Description
condition Any logical expression.
true_value The value to be returned if condition evaluates to True.
false_value The value to be returned if condition evaluates to False.
Example
This function returns Greater if the contents of A1 is greater than 10 and Less if the contents of A1 is less 
than 10:

IF(A1>10, "Greater", "Less") 
See Also

AND 
FALSE 
NOT 
OR 
TRUE 



 INDEX
Description
Returns the contents of a cell from a specified range. 
Syntax

INDEX ( reference [, row] [, column] [, range_number] )
Parameter Description
reference A reference to one or more ranges. If reference specifies more than one range, separate each 
reference with a comma and enclose reference in parentheses. For example, (A1:C6, B7:E14, F4). If each range in 
reference contains only one row or column, you can omit the row or column argument. For example, if reference is 
A1:A15, you can omit the column argument INDEX(A1:A15, 3,, 1).
row The row number in reference from which to return data.
column Column number in reference from which to return data.
range_number Specifies the range from which data is returned if reference contains more than one range. For 
example, if reference is (A1:A10, B1:B5, D14:E23), A1:A10 is range_number 1, B1:B5 is range_number 2, and 
D14:E23 is range_number 3.
Remarks
If row, column, and range_number do not point to a cell within reference, #REF! is returned. If row and 
column are omitted, INDEX returns the range in reference specified by range_number.
Examples
The following examples use this worksheet.

This function returns $1415.35:
INDEX(A2:B6, 2, 2)

This function returns $1634.58:
INDEX((A2:B6, D2:E6), 4, 2, 2)

See Also
CHOOSE 
HLOOKUP 
LOOKUP 
MATCH 
VLOOKUP 



 INDIRECT
Description
Returns the contents of the cell referenced by the specified cell.
Syntax

INDIRECT ( ref_text [, a1] )
Parameter Description
ref_text A reference to a cell that references a third cell. If ref_text is not a valid reference, the error #REF! is 
returned.
a1 The reference format. This argument must be TRUE() to represent an A1 reference format; SpreadPro does 
not support the R1C1 reference format.
Example
This function returns the contents of the cell that C1 references. If C1 contains "D1," then the contents of 
D1is returned: 

INDIRECT(C1)
See Also

OFFSET 



 INT
Description
Rounds the supplied number down to the nearest integer.
Syntax

INT ( number )
Parameter Description
number Any real number.
Examples
This function returns 10:

INT(10.99)
This function returns -11:

INT(–10.99)
See Also

CEILING 
FLOOR 
MOD 
ROUND 
TRUNC 



 IPMT
Description
Returns the interest payment of an annuity for a given period, based on regular payments and a fixed 
periodic interest rate.
Syntax

IPMT ( interest, per, nper, pv, [fv], [type] )
Parameter Description
interest The fixed periodic interest rate.
per The period for which to return the interest payment. This number must be between 1 and nper.
nper The number of payments.
pv The present value, or the lump sum amount the annuity is currently worth.
fv The future value, or the value after all payments are made. If this argument is omitted, the future value is 
assumed to be 0.
type Indicates when payments are due. Use 0 if payments are due at the end of the period or 1 if payments are 
due at the beginning of the period. When you omit this argument, 0 is assumed.
Remarks
The units used for interest must match those used for nper. For example, if the annuity has an 8 percent 
annual interest rate over a period of 5 years, specify 8 percent/12 for interest and 5*12 for nper.
Cash paid out, such as a payment, is shown as a negative number. Cash received, such as a dividend 
check, is shown as a positive number.
Examples
This function returns -117.87:

IPMT(8%/12, 2, 48, 18000)
This function returns -117.09:

IPMT(8%/12, 2, 48, 18000, 0, 1)
See Also

FV 
PMT 
PPMT 
RATE 



 IRR
Description
Returns internal rate of return for a series of periodic cash flows.
Syntax

IRR ( cash_flow [, guess] )
Parameter Description
cash_flow A reference to a range that contains values for which to calculate the internal rate of return. The 
values must contain at least one positive and one negative value. During calculation, IRR uses the order in which the 
values appear to determine the order of the cash flow. Text, logical values, and empty cells in the range are ignored.
guess The estimate of the internal rate of return. If no argument is supplied, a rate of return of 10 percent is 
assumed.
Remarks
The internal rate of return is the interest rate received for an investment consisting of payments (specified 
by negative numbers) and investments (specified by positive numbers).
IRR is calculated iteratively, cycling through the calculation until the result is accurate to .00001 percent. If
the result cannot be found after 20 iterations, #NUM! is returned. When this occurs, supply a different 
value for guess.
Examples
The following examples use this worksheet.

This function returns 3.72 percent:
IRR(B1:B6)

This function returns -49.26 percent:
IRR(B1:B3, –20%)

See Also
MIRR 
NPV 
RATE 



 ISBLANK
Description
Determines if the specified cell is blank.
Syntax

ISBLANK ( reference )
Parameter Description
reference A reference to any cell.
Remarks
If the referenced cell is blank, True is returned. False is returned if the cell is not blank.
Example
This function returns True if A1 is a blank cell:

ISBLANK(A1)
See Also

ISERR 
ISERROR 
ISLOGICAL 
ISNA 
ISNONTEXT 
ISNUMBER 
ISREF 
ISTEXT 



 ISERR
Description
Determines if the specified expression returns an error value.
Syntax

ISERR ( expression )
Parameter Description
expression Any expression.
Remarks
If the expression returns any error except #N/A!, True is returned. Otherwise, False is returned.
Example
This function returns True if A1 contains a formula that returns an error such as #NUM!:

ISERR(A1)
See Also

ISBLANK 
ISERROR 
ISLOGICAL 
ISNA 
ISNONTEXT 
ISNUMBER 
ISREF 
ISTEXT 



 ISERROR
Description
Determines if the specified expression returns an error value.
Syntax

ISERROR ( expression )
Parameter Description
expression Any expression.
Remarks
If the expression returns any error value, such as #N/A, #VALUE!, #REF!, #DIV/0!, #NUM!, #NAME?, or 
#NULL!, True is returned. Otherwise, False is returned.
Examples
This function returns True:

ISERROR(4/0)
This function returns False if A1 contains a formula that does not return an error.

ISERROR(A1)
See Also

ISBLANK 
ISERR 
ISLOGICAL 
ISNA 
ISNONTEXT 
ISNUMBER 
ISREF 
ISTEXT 



 ISLOGICAL
Description
Determines if the specified expression returns a logical value.
Syntax

ISLOGICAL ( expression )
Parameter Description
expression Any expression.
Remarks
If the expression returns a logical value, True is returned. Otherwise, False is returned.
Example
This function returns True because ISBLANK returns a logical value:

ISLOGICAL(ISBLANK(A1))
See Also

ISBLANK 
ISERR 
ISERROR 
ISNA 
ISNONTEXT 
ISNUMBER 
ISREF 
ISTEXT 



 ISNA
Description
Determines if the specified expression returns the value not available error.
Syntax

ISNA ( expression )
Parameter Description
expression Any expression.
Remarks
If the expression returns the #N/A! error, True is returned. Otherwise, False is returned.
Example
This function returns True if cell A1 contains the NA ( ) function or returns the error value #N/A!:

ISNA(A1)
See Also

ISBLANK 
ISERR 
ISERROR 
ISLOGICAL 
ISNONTEXT 
ISNUMBER 
ISREF 
ISTEXT 



 ISNONTEXT
Description
Determines if the specified expression is not text.
Syntax

ISNONTEXT ( expression )
Parameter Description
expression Any expression.
Remarks
If the expression returns any value that is not text, True is returned. Otherwise, False is returned.
Examples
This function returns True if cell F3 contains a number or is a blank cell:

ISNONTEXT(F3)
This function returns False:

ISNONTEXT("text")
See Also

ISBLANK 
ISERR 
ISERROR 
ISLOGICAL 
ISNA 
ISNUMBER 
ISREF 
ISTEXT 



 ISNUMBER
Description
Determines if the specified expression is a number.
Syntax

ISNUMBER ( expression )
Parameter Description
expression Any expression.
Remarks
If the expression returns a number, True is returned. Otherwise, False is returned. If expression returns a 
number represented as text (for example, "12"), False is returned.
Examples
This function returns True:

ISNUMBER(123.45) 
This function returns False:

ISNUMBER("123") 
See Also

ISBLANK 
ISERR 
ISERROR 
ISLOGICAL 
ISNA 
ISNONTEXT 
ISREF 
ISTEXT 



 ISREF
Description
Determines if the specified expression is a range reference.
Syntax

ISREF ( expression )
Parameter Description
expression Any expression.
Remarks
If the expression returns a range reference, True is returned. Otherwise, False is returned.
Example
This function returns True:

ISREF(A3) 
See Also

ISBLANK 
ISERR 
ISERROR 
ISLOGICAL 
ISNA 
ISNONTEXT 
ISNUMBER 
ISTEXT 



 ISTEXT
Description
Determines if the specified expression is text.
Syntax

ISTEXT ( expression )
Parameter Description
expression Any expression.
Remarks
If the expression returns text, True is returned. Otherwise, False is returned.
Example
This function returns True:

ISTEXT("2nd Quarter") 
See Also

ISBLANK 
ISERR 
ISERROR 
ISLOGICAL 
ISNA 
ISNONTEXT 
ISNUMBER 
ISREF 



 LEFT
Description
Returns the leftmost characters from the specified text string.
Syntax

LEFT ( text [, num_chars] ) 
Parameter Description
text Any text string.
num_chars The number of characters to return. This value must be greater than or equal to zero. If num_chars 
is greater than the number of characters in text, the entire string is returned. Omitting this argument assumes a value 
of 1.
Examples
This function returns 2:

LEFT("2nd Quarter")
This function returns 2nd:

LEFT("2nd Quarter", 3) 
See Also

MID 
RIGHT 



 LEFTB
Description
Returns the leftmost byte from the specified text string.
Syntax

LEFTB ( text [, num_chars] ) 
Parameter Description
text Any text string.
Num_chars The number of bytes to return. This value must be greater than or equal to zero. If num_chars is 
greater than the number of bytes in text, the entire string is returned. Omitting this argument assumes a value of 1.
Examples
This function returns 2:

LEFTB("2nd Quarter")
This function returns 2nd:

LEFTB("2nd Quarter", 3) 



 LEN
Description
Returns the number of characters in the supplied text string.
Syntax

LEN ( text )
Parameter Description
text Any text string. Spaces in the string are counted as characters.
Examples
This function returns 11:

LEN("3rd Quarter")
This function returns 3:

LEN("1-3") 
See Also

EXACT 
SEARCH 



 LENB
Description
Returns the number of bytes in the supplied text string.
Syntax

LENB ( text )
Parameter Description
text Any text string. Spaces in the string are counted as bytes.
Examples
This function returns 11:

LENB("3rd Quarter")
This function returns 3:

LENB("1-3") 



 LN
Description
Returns the natural logarithm (based on the constant e) of a number. 
Syntax

LN ( number )
Parameter Description
number Any positive real number.
Remarks
LN is the inverse of the EXP function.
Examples
This function returns 2.50:

LN(12.18)
This function returns 3.00:

LN(20.09)
See Also

EXP 
LOG 
LOG10 



 LOG
Description
Returns the logarithm of a number to the specified base.
Syntax

LOG ( number [, base] )
Parameter Description
number Any positive real number.
base The base of the logarithm. Omitting this argument assumes a base of 10.
Examples
This function returns 0:

LOG(1)
This function returns 1:

LOG(10)
See Also

EXP 
LN 
LOG10 



 LOG10
Description
Returns the base-10 logarithm of a number.
Syntax

LOG10 ( number )
Parameter Description
number Any positive real number.
Examples
This function returns 2.41:

LOG10(260)
This function returns 2:

LOG10(100)
See Also

EXP 
LN 
LOG 



 LOOKUP
Description
Searches for a value in one range and returns the contents of the corresponding position in a second 
range. 
Syntax

LOOKUP ( lookup_value, lookup_range, result_range )
Parameter Description
lookup_value The value for which to search in the first range.
lookup_range The first range to search and contains only one row or one column. The range can contain 
numbers, text, or logical values. To search lookup_range correctly, the expressions in the range must be placed in 
ascending order (for example, –2, –1, 0, 1, 2..., A through Z, False, True). The search is not case-sensitive. 
result_range A range of one row or one column that is the same size as lookup_range.
Remarks
If lookup_value does not have an exact match in lookup_range, the largest value that is less than or equal
to lookup_value is found and the corresponding position in result_range is returned. When lookup_value 
is smaller than the data in lookup_range, #N/A is returned.
Examples
The following examples use this worksheet.

This function returns Detroit:
LOOKUP("North", A2:A7, B2:B7) 

This function returns #N/A:
LOOKUP("Alabama", A2:A7, B2:B7)

See Also
HLOOKUP 
INDEX 
VLOOKUP 



 LOWER
Description
Changes the characters in the specified string to lowercase characters. Numeric characters in the string 
are not changed.
Syntax

LOWER ( text )
Parameter Description
text Any string.
Examples
This function returns 3rd quarter:

LOWER("3rd Quarter")
This function returns john doe:

LOWER("JOHN DOE")
See Also

PROPER 
UPPER 



 MATCH
Description
A specified value is compared against values in a range. The position of the matching value in the search 
range is returned.
Syntax

MATCH ( lookup_value, lookup_range, comparison )
Parameter Description
lookup_value The value against which to compare. It can be a number, text, or logical value or a reference to a 
cell that contains one of those values.
lookup_range The range to search; it contains only one row or one column. The range can contain numbers, text, 
or logical values.
comparison A number that represents the type of comparison to be made between lookup_value and the values
in lookup_range. When you omit this argument, comparison method 1 is assumed. When comparison is 0, the first 
value that is equal to lookup_value is matched. When using this comparison method, the values in lookup_range can 
be in any order. When comparison is 1, the largest value that is less than or equal to lookup_value is matched. When 
using this comparison method, the values in lookup_range must be in ascending order (for example, ...-2, -1, 0, 1, 
2..., A through Z, False, True). When comparison is -1, the smallest value that is greater than or equal to 
lookup_value is matched. When using this comparison method, the values in lookup_range must be in descending 
order (for example, True, False, Z through A, ...2, 1, 0, -1, -2...).
Remarks
When using comparison method 0 and lookup_value is text, lookup_value can contain wildcard 
characters. The wildcard characters are * (asterisk), which matches any sequence of characters, and ? 
(question mark), which matches any single character.
When no match is found for lookup_value, #N/A is returned.
Examples
The following examples use this worksheet.

This function returns 5:
MATCH(7600, B2:B7,1)

This function returns 2:
MATCH("D*", A2:A7,0)

See Also
HLOOKUP 
INDEX 
LOOKUP 
VLOOKUP 



 MAX
Description
Returns the largest value in the specified list of numbers. 
Syntax

MAX ( number_list )
Parameter Description
number_list A list of as many as 30 numbers, separated by commas.
 The list can contain numbers, logical values, text representations of numbers, or a reference to a range 
containing those values. Error values or text that cannot be translated into numbers return errors.
. If a range reference is included in the list, text, logical expressions, and empty cells in the range are ignored 
If there are no numbers in the list, 0 is returned.
Examples
This function returns 500:

MAX(50, 100, 150, 500, 200)
This function returns the largest value in the range:

MAX(A1:F12)
See Also

AVERAGE 
MIN 



 MID
Description
Returns the specified number of characters from a text string, beginning with the specified starting 
position.
Syntax

MID ( text, start_position, num_chars )
Parameter Description
text The string from which to return characters.
start_position The position of the first character to return from text. 

If start_position is 1, the first character in text is returned. If start_position is greater than the number of 
characters in text, an empty string (" ") is returned.    If start_position is less than 1, #VALUE! is returned.
num_chars The number of characters to return. If num_chars is negative, #VALUE! is returned.
Remarks
If start_position plus the number of characters in num_chars exceeds the length of text, the characters 
from start_position to the end of text are returned.
Examples
This function returns Expenses:

MID("Travel Expenses", 8, 8)
This function returns 45:

MID("Part #45-7234", 7, 2)
See Also

CODE 
FIND 
LEFT 
RIGHT 
SEARCH 



 MIDB
Description
Returns the specified number of bytes from a text string, beginning with the specified starting position.
Syntax

MIDB ( text, start_position, num_chars )
Parameter Description
text The string from which to return bytes.
start_position The position of the first byte to return from text. 

If start_position is 1, the first byte in text is returned. If start_position is greater than the number of bytes in 
text, an empty string (" ") is returned.    If start_position is less than 1, #VALUE! is returned.
num_chars The number of bytes to return. If num_chars is negative, #VALUE! Is returned.
Remarks
If start_position plus the number of bytes in num_chars exceeds the length of text, the bytes from 
start_position to the end of text are returned.
Examples
This function returns Expenses:

MIDB("Travel Expenses", 8, 8)
This function returns 45:

MIDB("Part #45-7234", 7, 2)



 MIN
Description
Returns the smallest value in the specified list of numbers. 
Syntax

MIN ( number_list )
Parameter Description
number_list A list of as many as 30 numbers, separated by commas. The list can contain numbers, logical 
values, text representations of numbers, or a reference to a range containing those values. 

Error values or text that cannot be translated into numbers return errors. If a range reference is included in 
the list, text, logical expressions, and empty cells in the range are ignored. If there are no numbers in the list, 0 is 
returned
Examples
This function returns 50:

MIN(50, 100, 150, 500, 200)
This function returns the smallest value in the range:

MIN(A1:F12)
See Also

AVERAGE 
MAX 



 MINUTE
Description
Returns the minute that corresponds to the supplied date.
Syntax

MINUTE ( serial_number )
Parameter Description
serial_number The time as a serial number. The decimal portion of the number represents time as a fraction of the
day.
Remarks
The result is an integer ranging from 0 to 59.
Examples
This function returns 36:

MINUTE(34506.4)
This function returns 48:

MINUTE(34399.825)
See Also

DAY 
HOUR 
MONTH 
NOW 
SECOND 
WEEKDAY 
YEAR 



 MIRR
Description
Returns the modified internal rate of return for a series of periodic cash flows. 
Syntax

MIRR ( cash_flows, finance_rate, reinvest_rate )
Parameter Description
cash_flow A reference to a range that contains values for which to calculate the modified internal rate of 
return. The values must contain at least one positive and one negative value. 

Values that represent cash received should be positive; negative values represent cash paid. During 
calculation, MIRR uses the order in which the values appear to determine the order of cash flow. Text, logical values, 
and empty cells in the range are ignored.
finance_rate The interest rate paid on money used in the cash flow.
reinvest_rate The interest rate received on money reinvested from the cash flow.
Remarks
The modified internal rate of return considers the cost of the investment and the interest received on the 
reinvestment of cash.
Examples
The following examples use this worksheet.
This function returns 5.20 percent:

MIRR(B1:B6, 12%, 8%)
This function returns –40.93 percent:

MIRR(B1:B3, 12%, 8%)
See Also

IRR 
NPV 
RATE 



 MOD
Description
Returns the remainder after dividing a number by a specified divisor.
Syntax

MOD ( number, divisor )
Parameter Description
number Any number.
divisor Any nonzero number. If divisor is 0, #DIV/0! is returned.
Examples
This function returns 1:

MOD(–23, 3) 
This function returns -2:

MOD(–23, –3)
See Also

INT 
ROUND 
TRUNC 



 MONTH
Description
Returns the month that corresponds to the supplied date.
Syntax

MONTH ( serial_number )
Parameter Description
serial_number The date as a serial number or as text (for example, 06-21-94 or 21-Jun-94).
Remarks
MONTH returns a number ranging from 1 (January) to 12 (December).
Examples
This function returns 6:

MONTH("06-21-94")
This function returns 10:

MONTH(34626)
See Also

DAY 
HOUR 
MINUTE 
NOW 
SECOND 
TODAY 
WEEKDAY 
YEAR 



 NA
Description
Returns the error value #N/A, which represents "not available." 
Syntax

NA ( )
Remarks
Use NA to mark cells that lack data without leaving them empty. Empty cells may not be correctly 
represented in some calculations.
Although NA does not use arguments, you must supply the empty parentheses to correctly reference the 
function.
See Also

ISNA 



 NOT
Description
Returns a logical value that is the opposite of its value.
Syntax

NOT ( logical )
Parameter Description
logical An expression that returns a logical value such as True or False.
Remarks
If logical is false, NOT returns True. Conversely, if logical is true, NOT returns False.
Examples
This function returns False:

NOT(TRUE())
This function returns False:

NOT(MONTH("12/25/94") = 12) 
See Also

AND 
IF 
OR 



 NOW
Description
Returns the current date and time as a serial number. 
Syntax

NOW ( )
Remarks
In a serial number, numbers to the left of the decimal point represent the date; numbers to the right of the 
decimal point represent the time. The result of this function changes only when a recalculation of the 
worksheet occurs.
See Also

DATE 
DAY 
HOUR 
MINUTE 
MONTH 
SECOND 
TODAY 
WEEKDAY 
YEAR 



 NPER
Description
Returns the number of periods of an investment based on regular periodic payments and a fixed interest 
rate.
Syntax

NPER ( interest, pmt, pf [, fv] [, type] )
Parameter Description
interest The fixed interest rate.
pmt The fixed payment made each period. Generally, pmt includes the principle and interest, not taxes or other 
fees.
pf The present value, the lump-sum amount that a series of future payments is currently worth.
fv The future value, the balance to attain after the final payment. Omitting this argument assumes a future 
balance of 0.
type Indicates when payments are due. Use 0 if payments are due at the end of the period or 1 if payments are 
due at the beginning of the period. When you omit this argument, 0 is assumed.
Examples
This function returns 36.67:

NPER(12%/12, –350, –300, 16000, 1)
This function returns 36.98:

NPER(1%, –350, –300, 16000) 
See Also

FV 
IPMT 
PMT 
PPMT 
PV 
RATE 



 NPV
Description
Returns the net present value of an investment based on a series of periodic payments and a discount 
rate. 
Syntax

NPV ( discount_rate, value_list ) 
Parameter Description
discount_rate The rate of discount for one period.
value_list A list of as many as 29 arguments or a reference to a range that contains values that represent 
payments and income. During calculation, NPV uses the order in which the values appear to determine the order of 
cash flow. Numbers, empty cells, and text representations of numbers are included in the calculation. Errors and text 
that cannot be translated into numbers are ignored.    If value_list is a range reference, only numeric data in the range
is included in the calculation. Other types of data in the range, such as empty cells, logical values, text, and error 
values are ignored. 
Remarks
The time span NPV uses for calculation begins one period before the first cash flow date and ends when 
the last cash flow payment is made. This function is based on future cash flows. When your first cash flow
occurs at the beginning of the first period, the first value must be added to the NPV result, not supplied as
a value in value_list.
Example
This function returns 811.57:

NPV(8%, –12000, 3000, 3000, 3000, 7000) 
See Also

FV 
IRR 
PV 



 ODD
Description
Rounds the specified number up to the nearest odd integer.
Syntax

ODD ( number )
Parameter Description
number Any number, a formula that evaluates to a number, or a reference to a cell that contains a number.
Examples
This function returns 5:

ODD(3.5)
This function returns 7:

ODD(6)
See Also

CEILING 
EVEN 
FLOOR 
INT 
ROUND 
TRUNC 



 OFFSET
Description
Returns the contents of a range that is offset from a starting point in the spreadsheet.
Syntax

OFFSET ( reference, rows, columns [, height] [, width] )
Parameter Description
reference A reference to a cell from which the offset reference is based. If you specify a range reference, 
#VALUE! is returned.
rows The number of rows from reference that represents the upper-left cell of the offset range. A positive number 
represents rows below the starting cell; a negative number represents rows above the starting cell. If rows places the 
upper-left cell of the offset range outside the spreadsheet boundary, #REF! is returned.
columns The number of columns from reference that represents the upper-left cell of the offset range. A positive 
number represents columns right of the starting cell; a negative number represents columns left of the starting cell. If 
columns places the upper-left cell of the offset range outside the spreadsheet boundary, #REF! is returned.
height A positive number representing the number of rows to include in the offset range. Omitting this argument 
assumes a single row.
width A positive number representing the number of columns to include in the offset range. Omitting this argument 
assumes a single column.
Remarks
OFFSET does not change the current selection in the worksheet. Because it returns a reference, 
OFFSET can be used in any function that requires or uses a cell or range reference as an argument.
Examples
This function returns the contents of cell D4:

OFFSET(B1, 3, 2, 1, 1)
This function returns the sum of the values in the range E3:F5:

SUM(OFFSET(A1, 2, 4, 3, 2)) 



 OR
Description
Returns True if at least one of a series of logical arguments is true.
Syntax

OR ( logical_list )
Parameter Description
logical_list A list of conditions separated by commas. You can include as many as 30 conditions in the list. The
list can contain logical values or a reference to a range containing logical values. Text and empty cells are ignored. If 
there are no logical values in the list, the error value #VALUE! is returned.
Example
This function returns True because one of the arguments is true:

OR(1 + 1 = 1, 5 + 5 = 10)
See Also

AND 
IF 
NOT 



 PI
Description
Returns the value of pi (p), which is approximately 3.14159265358979 when calculated to 15 significant 
digits.
Syntax

PI ( )
Remarks
Although PI does not use arguments, you must supply the empty parentheses to correctly reference the 
function. 
See Also

COS 
SIN 
TAN 



 PMT
Description
Returns the periodic payment of an annuity, based on regular payments and a fixed periodic interest rate. 
Syntax

PMT ( interest, nper, pv [, fv] [, type] )
Parameter Description
interest The fixed periodic interest rate.
nper The number of periods in the annuity.
pv The present value, or the amount the annuity is currently worth.
fv The future value, or the amount the annuity will be worth. When you omit this argument, a future value of 0 
is assumed.
type Indicates when payments are due. Use 0 if payments are due at the end of the period or 1 if payments are 
due at the beginning of the period. When you omit this argument, 0 is assumed.
Remarks
PMT returns only the principal and interest payment, it does not include taxes or other fees.
The units used for interest must match those used for nper. For example, if the annuity has an 8 percent 
annual interest rate over a period of 5 years, specify 8 percent/12 for interest and 5*12 for nper.
Cash paid out, such as a payment, is shown as a negative number. Cash received, such as a dividend 
check, is shown as a positive number.
Examples
This function returns -439.43:

PMT(8%/12, 48, 18000)
This function returns -436.52:

PMT(8%/12, 48, 18000, 0, 1)
See Also

IPMT 
FV 
NPER 
PPMT 
PV 
RATE 



 PPMT
Description
Returns the principle paid on an annuity for a given period.
Syntax

PPMT ( interest, per, nper, pv, [fv], [type] )
Parameter Description
interest The fixed periodic interest rate.
per The period for which to return the principle.
nper The number of periods in the annuity.
pv The present value, or the amount the annuity is currently worth.
fv The future value, or the amount the annuity will be worth. When you omit this argument, a future value of 0 
is assumed.
type Indicates when payments are due. Use 0 if payments are due at the end of the period or 1 if payments are 
due at the beginning of the period. When you omit this argument, 0 is assumed.
Remarks
The units used for interest must match those used for nper. For example, if the annuity has an 8 percent 
annual interest rate over a period of 5 years, specify 8 percent/12 for interest and 5*12 for nper.
Examples
This function returns -321.56:

PPMT(8%/12, 2, 48, 18000)
This function returns -319.43:

PPMT(8%/12, 2, 48, 18000, 0, 1)
See Also

FV 
IPMT 
NPER 
PMT 
PV 
RATE 



 PRODUCT
Description
Multiplies a list of numbers and returns the result.
Syntax

PRODUCT ( number_list )
Parameter Description
number_list A list of as many as 30 numbers, separated by commas. The list can contain numbers, logical 
values, text representations of numbers, or a reference to a range containing those values. Error values or text that 
cannot be translated into numbers return errors. If a range reference is included in the list, text, logical expressions, 
and empty cells in the range are ignored. All numeric values, including 0, are used in the calculation.
Example
This function returns 24:

PRODUCT(1, 2, 3, 4) 
See Also

FACT 
SUM 



 PROPER
Description
Returns the specified string in proper-case format.
Syntax

PROPER ( text )
Parameter Description
text Any string.
Remarks
In proper-case format, the first alphabetic character in a word is capitalized. If an alphabetic character 
follows a number, punctuation mark, or space, it is capitalized. All other alphabetic characters are 
lowercase. Numbers are not changed by PROPER.
Examples
This function returns 3Rd Quarter:

=PROPER("3rd Quarter")
This function returns John Doe:

=PROPER("JOHN DOE")
See Also

LOWER 
UPPER 



 PV
Description
Returns the present value of an annuity, considering a series of constant payments made over a regular 
payment period.
Syntax

PV ( interest, nper, pmt [, fv] [, type] )
Parameter Description
interest The fixed periodic interest rate.
nper The number of payment periods in the investment.
pmt The fixed payment made each period.
fv The future value, or the amount the annuity will be worth. When you omit this argument, a future value of 0 
is assumed.
type Indicates when payments are due. Use 0 if payments are due at the end of the period or 1 if payments are 
due at the beginning of the period. When you omit this argument, 0 is assumed.
Remarks
The units used for interest must match those used for nper. For example, if the annuity has an 8 percent 
annual interest rate over a period of 5 years, specify 8 percent/12 for interest and 5*12 for nper.
Cash paid out, such as a payment, is shown as a negative number. Cash received, such as a dividend 
check, is shown as a positive number.
Examples
This function returns -17999.89:

PV(8%/12, 48, 439.43)
This function returns 17999.89:

PV(8%/12, 48, -439.43)
See Also

FV 
IPMT 
NPER 
PMT 
PPMT 
RATE 



 RAND
Description
Returns a number selected randomly from a uniform distribution greater than or equal to 0 and less than 
1.
Syntax

RAND ( )
Remarks
Although RAND does not use arguments, you must supply the empty parentheses to correctly reference 
the function. 
Example
This function returns a random number greater than or equal to 0 and less than 10:.

RAND()*10 



 RATE
Description
Returns the interest rate per period of an annuity, given a series of constant cash payments made over a 
regular payment period.
Syntax

RATE ( nper, pmt, pv [, fv] [, type] [, guess] )
Parameter Description
nper The number of periods in the annuity.
pmt The fixed payment made each period. Generally, pmt includes only principle and interest, not taxes or other 
fees.
pv The present value of the annuity.
fv The future value, or the amount the annuity will be worth. When you omit this argument, a future value of 0 
is assumed.
type Indicates when payments are due. Use 0 if payments are due at the end of the period or 1 if payments are 
due at the beginning of the period. When you omit this argument, 0 is assumed.
guess Your estimate of the interest rate. If no argument is supplied, a value of 0.1 (10 percent) is assumed.
Remarks
RATE is calculated iteratively, cycling through the calculation until the result is accurate to .00001 percent.
If the result cannot be found after 20 iterations, #NUM! is returned. When this occurs, supply a different 
value for guess.
Example
The following example returns the monthly interest rate of .0067; the annual interest rate (.0067 multiplied
by 12) is 8 percent:

RATE(48, –439.43, 18000) 
See Also

FV 
IPMT 
NPER 
PMT 
PPMT 
PV 



 REGISTER.ID
Description
Returns the register ID of the specified dynamic link library (DLL) that has been previously registered. If 
the DLL has not been registered, this function registers the DLL, and then returns the register ID.
Syntax

REGISTER.ID(module_text, procedure, type_text)
Parameter Description
module_text The text specifying the name of the DLL that contains the function in SpreadPro.
procedure The text specifying the name of the function in the DLL in SpreadPro. The function name is case 
dependent in 32-bit SpreadPro.
type_text The text specifying the data type of the return value and the data types of all arguments to the DLL.
The first letter of type_text specifies the return value. If the function or code resource is already registered, you can 
omit this argument. For a complete list of the data types available, see the type_text parameter of the CALL 
worksheet function.
Remarks
For declarations made in C, it is assumed that your compiler defaults to 8-byte doubles, 2-byte short 
integers, and 4-byte long integers. In the Windows programming environment, all pointers should be far 
pointers.
Pascal calling conventions are used for all functions called from DLLs. For most C compilers, you must 
add the –Pascal keyword to the function declaration.
If the return value for your custom function uses a pass-by-reference data type, a null pointer can be 
passed as the return value. The null pointer is interpreted as the #NUM! error value.
For the F and G data types, a custom function can modify an allocated string buffer. If the return value 
type code is F or G, the value returned by the function is ignored. The list of function arguments is 
searched for the first data type that corresponds to the return value type. The current contents of the 
allocated string buffer is taken for the return value. 256 bytes is allocated for the argument; therefore, a 
function can return a larger string than it receives.
You can use a single digit (n), with a value from 1 to 9, as the code for data_type. The variable in the 
location pointed to by the nth argument is modified instead of the return value; this process is referred to 
as modifying in place. The nth argument must be a pass-by-reference data type. In addition, you must 
declare the function void. For most C compilers, you can add the Void keyword to the function 
declaration.
Examples
(32-bit SpreadPro)
The following formula registers the GetTickCount function from 32-bit SpreadPro and returns the register 
ID:

REGISTER.ID("Kernel32", "GetTickCount", "J!")
Assuming that GetTickCount was already registered on another sheet using the preceding formula, the 
following formula returns the register ID for GetTickCount: 

REGISTER.ID("Kernel32", "GetTickCount")
(16-bit SpreadPro)
The following formula registers the GetTickCount function from 16-bit SpreadPro and returns the register 
ID:

REGISTER.ID("User", "GetTickCount", "J!")
Assuming that GetTickCount was already registered on another sheet using the preceding formula, the 
following formula returns the register ID for GetTickCount: 

REGISTER.ID("User", "GetTickCount")



 REPLACE
Description
Replaces part of a text string with another text string.
Syntax

REPLACE ( orig_text, start_position, num_chars, repl_text )
Parameter Description
orig_text The original text string.
start_position The character position where the replacement begins. If start_position is greater than the number 
of characters in orig_text, repl_text is appended to the end of orig_text. If start_position is less than 1, #VALUE! is 
returned.
num_chars The number of characters to replace. If this argument is negative, #VALUE! is returned.
repl_text The replacement text string.
Examples
This function returns "For the year: 1994":

REPLACE("For the year: 1993", 18, 1, "4") 
See Also

MID 
SEARCH 
TRIM 



 REPLACEB
Description
Replaces part of a text string with another text string.
Syntax

REPLACEB ( orig_text, start_position, num_chars, repl_text )
Parameter Description
orig_text The original text string.
start_position The byte position where the replacement begins. If start_position is greater than the number of 
bytes in orig_text, repl_text is appended to the end of orig_text. If start_position is less than 1, #VALUE! is returned.
num_chars The number of bytes to replace. If this argument is negative, #VALUE! Is returned.
repl_text The replacement text string.
Examples
This function returns "For the year: 1994":

REPLACEB("For the year: 1993", 18, 1, "4") 



 REPT
Description
Repeats a text string the specified number of times.
Syntax

REPT ( text, number )
Parameter Description
text Any text string.
number The number of times you want text to repeat. If number is 0, empty text (" ") is returned.
Remarks
The result of REPT cannot exceed 255 characters.
Example
This function returns error-error-error-:

REPT("error-", 3) 



 RIGHT
Description
Returns the rightmost characters from the given text string.
Syntax

RIGHT ( text [, num_chars] )
Parameter Description
text Any text string.
num_chars The number of characters to return. The value must be greater than or equal to zero. If num_chars 
is greater than the number of characters in text, the entire string is returned. Omitting this argument assumes a value 
of 1.
Examples
This function returns r:

RIGHT("2nd Quarter")
This function returns Quarter:

RIGHT("2nd Quarter", 7) 
See Also

LEFT 
MID 



 RIGHTB
Description
Returns the rightmost bytes from the given text string.
Syntax

RIGHTB ( text [, num_chars] )
Parameter Description
text Any text string.
num_chars The number of bytes to return. The value must be greater than or equal to zero. If num_chars is 
greater than the number of bytes in text, the entire string is returned. Omitting this argument assumes a value of 1.
Examples
This function returns r:

RIGHTB("2nd Quarter")
This function returns Quarter:

RIGHTB("2nd Quarter", 7) 



 ROUND
Description
Rounds the given number to the supplied number of decimal places.
Syntax

ROUND ( number, precision )
Parameter Description
number Any value.
precision The number of decimal places to which number is rounded.    When a negative precision is used, 
the digits to the right of the decimal point are dropped and the absolute number of significant digits specified by 
precision are replaced with zeros. If precision is 0, number is rounded to the nearest integer.
Example
This function returns 123.46:

ROUND(123.456, 2)
This function returns 9900:

ROUND(9899.435, –2)
See Also

CEILING 
FLOOR 
INT 
MOD 
ROUNDDOWN 
ROUNDUP 
TRUNC 



 ROUNDDOWN
Description
Rounds a number down.
Syntax

ROUNDDOWN ( number, numberOfDigits )
Parameter Description
number Any real number you want to round.
numberOfDigits The number of decimal places to which number is rounded.    When a negative precision is used, 
the digits to the right of the decimal point are dropped and the absolute number of significant digits specified by 
precision are replaced with zeros. If precision is 0, number is rounded down to the nearest integer.
Example
This function returns 3.141:

ROUNDDOWN(3.14159, 3)
This function returns 31400:

ROUNDDOWN(31415.92654, -2)
See Also

CEILING 
FLOOR 
INT 
MOD 
ROUNDDOWN 
ROUNDUP 
TRUNC 



 ROUNDUP
Description
Rounds the given number up to the supplied number of decimal places.
Syntax

ROUNDUP ( number, numberOfDigits )
Parameter Description
number Any value you want to round up.
numberOfDigits The number of decimal places to which number is rounded.    When a negative precision is used, 
the digits to the right of the decimal point are dropped and the absolute number of significant digits specified by 
precision are replaced with zeros. If precision is 0, number is rounded up to the nearest integer.
Example
This function returns 77:

ROUNDUP(76.9,0)
This function returns 31500:

ROUNDUP(31415.92654, -2) 
See Also

CEILING 
FLOOR 
INT 
MOD 
ROUND 
ROUNDDOWN 
TRUNC 



 ROW
Description
Returns the row number of the supplied reference. 
Syntax

ROW ( reference )
Parameter Description
reference A cell or range reference. Omitting this argument returns the row number of the cell in which ROW 
is entered.
Examples
This function returns 3:

ROW(B3)
See Also

COLUMN 
ROWS 



 ROWS
Description
Returns the number of rows in a range reference.
Syntax

ROWS ( range )
Parameter Description
range A reference to a range of cells.
Examples
This function returns 5:

ROWS(A1:D5)
This function returns 6:

ROWS(C30:F35)
See Also

COLUMNS 
ROW 



 SEARCH
Description
Locates the position of the first character of a specified text string within another text string.
Syntax

SEARCH ( search_text, text [, start_position] )
Parameter Description
search_text The text to find. To search for an asterisk or question mark, include a tilde (~) before the character. 
The search string can contain wildcard characters. The available wildcard characters are * (asterisk), which matches 
any sequence of characters, and ? (question mark), which matches any single character.
text The text to be searched.
start_position The character position where the search begins. If the number you specify is less than 0 or greater 
than the number of characters in text, #VALUE! is returned. Omitting this argument assumes a starting position of 1.
Remarks
Text is searched from left to right, starting at the position specified. The search is not case-sensitive. If 
text does not contain the search string, #VALUE! is returned.
Examples
This function returns 6:

SEARCH("?5", "Bin b45")
This function returns 5:

SEARCH("b", "Bin b45", 4)
See Also

FIND 
MID 
REPLACE 
SUBSTITUTE 



 SEARCHB
Description
Locates the position of the first byte of a specified text string within another text string.
Syntax

SEARCHB ( search_text, text [, start_position] )
Parameter Description
search_text The text to find. To search for an asterisk or question mark, include a tilde (~) before the character. 
The search string can contain wildcards. The available wildcard characters are * (asterisk), which matches any 
sequence of characters, and ? (question mark), which matches any single character.
Text The text to be searched.
start_position The byte position where the search begins. If the number you specify is less than 0 or greater than 
the number of bytes in text, #VALUE! is returned. Omitting this argument assumes a starting position of 1.
Remarks
Text is searched from left to right, starting at the position specified. The search is not case-sensitive. If 
text does not contain the search string, #VALUE! is returned.
Examples
This function returns 6:

SEARCHB("?5", "Bin b45")
This function returns 5:

SEARCHB("b", "Bin b45", 4)



 SECOND
Description
Returns the second that corresponds to the supplied date.
Syntax

SECOND ( serial_number )
Parameter Description
serial_number The time as a serial number. The decimal portion of the number represents time as a fraction of the
day.
Examples
This function returns 58:

SECOND(.259)
This function returns 46:

SECOND(34657.904)
See Also

DAY 
HOUR 
MINUTE 
MONTH 
NOW 
WEEKDAY 



 SIGN
Description
Determines the sign of the specified number.
Syntax

SIGN ( number )
Parameter Description
number Any number.
Remarks
SIGN returns 1 if the specified number is positive, -1 if it is negative, and 0 if it is 0.
Examples
This function returns -1:

SIGN(–123)
This function returns 1:

SIGN(123)
See Also

ABS 



 SIN
Description
Returns the sine of the supplied angle. 
Syntax

SIN ( number )
Parameter Description
number The angle in radians. If the angle is in degrees, convert the angle to radians by multiplying the angle by 
PI( )/180.
Examples
This function returns .85:

SIN(45)
This function returns .89:

SIN(90)
See Also

ASIN 
PI 



 SINH
Description
Returns the hyperbolic sine of the specified number. 
Syntax

SINH ( number )
Parameter Description
number Any number.
Examples
This function returns 1.18:

SINH(1) 
This function returns 10.02:

SINH(3) 
See Also

ASINH 
PI 



 SLN
Description
Returns the depreciation of an asset for a specific period of time using the straight-line balance method. 
Syntax

SLN ( cost, salvage, life )
Parameter Description
cost The initial cost of the asset.
salvage The salvage value of the asset.
life The number of periods of the useful life of the asset.
Example
This function returns 1285.71:

SLN(10000, 1000, 7)
See Also

DDB 
SYD 
VDB 



 SQRT
Description
Returns the square root of the specified number. 
Syntax

SQRT ( number )
Parameter Description
number Any positive number. If you specify a negative number, the error #NUM! is returned.
Examples
This function returns 3:

SQRT(9) 
This function returns 1.58:

SQRT(2.5)
See Also

SUMSQ 



 STDEV
Description
Returns the standard deviation of a population based on a sample of supplied values. The standard 
deviation of a population represents an average of deviations from the population mean within a list of 
values.
Syntax

STDEV ( number_list )
Parameter Description
number_list A list of as many as 30 numbers, separated by commas. The list can contain numbers or a 
reference to a range that contains numbers.
Example
This function returns .56:

STDEV(4.0, 3.0, 3.0, 3.5, 2.5, 4.0, 3.5)
See Also

STDEVP 
VAR 
VARP 



 STDEVP
Description
Returns the standard deviation of a population based on an entire population of values. The standard 
deviation of a population represents an average of deviations from the population mean within a list of 
values.
Syntax

STDEVP ( number_list )
Parameter Description
number_list A list of as many as 30 numbers, separated by commas. The list can contain numbers or a 
reference to a range that contains numbers.
Example
This function returns .52:

STDEVP(4.0, 3.0, 3.0, 3.5, 2.5, 4.0, 3.5)
See Also

STDEV 
VAR 
VARP 



 SUBSTITUTE
Description
Replaces a specified part of a text string with another text string.
Syntax

SUBSTITUTE ( text, old_text, new_text [, instance] )
Parameter Description
text A text string that contains the text to replace. You can also specify a reference to a cell that contains text.
old_text The text string to be replaced.
new_text The replacement text.
instance Specifies the occurrence of old_text to replace. If this argument is omitted, every instance of old_text is 
replaced.
Examples
This function returns "Second Quarter Results":

SUBSTITUTE("First Quarter Results", "First", "Second") 
This function returns "Shipment 45, Bin 52":

SUBSTITUTE("Shipment 45, Bin 45", "45", "52", 2) 
See Also

REPLACE 
TRIM 



 SUM
Description
Returns the sum of the supplied numbers.
Syntax

SUM ( number_list ) 
Parameter Description
number_list A list of as many as 30 numbers, separated by commas.    The list can contain numbers, logical 
values, text representations of numbers, or a reference to a range containing those values.    Error values or text that 
cannot be translated into numbers return errors. If a range reference is included in the list, text, logical expressions, 
and empty cells in the range are ignored.
Examples
This function returns 6000:

SUM(1000, 2000, 3000)
This function returns 4000 when each cell in the range contains 1000:

SUM(A10:D10)
See Also

AVERAGE 
COUNT 
COUNTA 
PRODUCT 
SUMSQ 



 SUMIF
Description
Returns the sum of the specified cells based on the given criteria.
Syntax

SUMIF ( range, criteria, sum_range ) 
Parameter Description
range The range of cells you want evaluated.
criteria A number, expression, or text that defines which cells are added. For example, criteria can be expressed as 
15, "15", ">15", "cars".
sum_range The actual cells to sum. These cells are only summed if their corresponding cells in range match 
the criteria. If this argument is omitted, the cells in range are summed.
See Also

AVERAGE 
COUNT 
COUNTA 
COUNTIF 
PRODUCT 
SUM 



 SUMSQ
Description
Squares each of the supplied numbers and returns the sum of the squares.
Syntax

SUMSQ ( number_list )
Parameter Description
number_list A list of as many as 30 numbers, separated by commas.    The list can contain numbers, logical 
values, text representations of numbers, or a reference to a range containing those values.    Error values or text that 
cannot be translated into numbers return errors. If a range reference is included in the list, text, logical expressions, 
and empty cells in the range are ignored.
Example
This function returns 302:

SUMSQ(9, 10, 11)
See Also

SUM 



 SYD
Description
Returns the depreciation of an asset for a specified period using the sum-of-years method. This 
depreciation method uses an accelerated rate, where the greatest depreciation occurs early in the useful 
life of the asset.
Syntax

SYD ( cost, salvage, life, period )
Parameter Description
cost The initial cost of the asset.
salvage The salvage value of the asset.
life The number of periods in the useful life of the asset.
period The period for which to calculate the depreciation. The time units used to determine per and life must match.
Example
This function returns 1607.14:

SYD(10000, 1000, 7, 3)
See Also

DDB 
SLN 
VDB 



 TAN
Description
Returns the tangent of the specified angle. 
Syntax

TAN ( number )
Parameter Description
number The angle in radians. To convert a number expressed as degrees to radians, multiply the degrees by PI( 
)/180.
Example
This function returns 0.752:

TAN(0.645)
This function returns 1:

TAN(45*PI()/180) 
See Also

ATAN 
ATAN2 
PI 
TANH 



 TANH
Description
Returns the hyperbolic tangent of a number.
Syntax

TANH ( number )
Parameter Description
number Any number.
Examples
This function returns -.96:

TANH(-2)
This function returns .83:

TANH(1.2)
See Also

ATANH 
COSH 
SINH 
TAN 



 TEXT
Description
Returns the given number as text, using the specified formatting.
Syntax

TEXT ( number, format )
Parameter Description
number Any value, a formula that evaluates to a number, or a reference to a cell that contains a value.
format A string representing a number format. The string can be any valid format string including "General," 
"M/DD/YY," or "H:MM AM/PM." The format must be surrounded by a set of double quotation marks. Asterisks cannot 
be included in format.
Examples
This function returns 123.620:

TEXT(123.62, "0.000")
This function returns 10/19/94:

TEXT(34626.2, "MM/DD/YY")
See Also

DOLLAR 
FIXED 
T 
VALUE 



 TIME
Description
Returns a serial number for the supplied time.
Syntax

TIME ( hour, minute, second )
Parameter Description
hour A number from 0 to 23.
minute A number from 0 to 59.
second A number from 0 to 59.
Examples
This function returns .52:

TIME(12, 26, 24)
This function returns .07:

TIME(1, 43, 34)
See Also

HOUR 
MINUTE 
NOW 
SECOND 
TIMEVALUE 



 TIMEVALUE
Description
Returns a serial number for the supplied text representation of time.
Syntax

TIMEVALUE ( text )
Parameter Description
text A time in text format.
Examples
This function returns .07:

TIMEVALUE("1:43:43 am")
This function returns .59:

TIMEVALUE("14:10:07")
See Also

HOUR 
MINUTE 
NOW 
SECOND 
TIME 



 TODAY
Description
Returns the current date as a serial number. 
Syntax

TODAY ( )
Remarks
This function is updated only when the worksheet is recalculated.
See Also

DATE 
DAY 
NOW 



 TRIM
Description
Removes all spaces from text except single spaces between words. 
Syntax

TRIM ( text )
Parameter Description
text Any text string or a reference to a cell that contains a text string.
Remarks
Text that is imported from another environment may require this function.
Example
This function returns Level 3, Gate 45:

TRIM(" Level 3, Gate 45 ")
See Also

CLEAN 
MID 
REPLACE 
SUBSTITUTE 



 TRUE
Description
Returns the logical value True. This function always requires the trailing parentheses.
Syntax

TRUE ( )
See Also

FALSE 



 TRUNC
Description
Truncates the given number to an integer.
Syntax

TRUNC ( number [, precision] )
Parameter Description
number Any value.
precision The number of decimal places allowed in the truncated number. Omitting this argument assumes a 
precision of 0.
Remarks
TRUNC removes the fractional part of a number to the specified precision without rounding the number.
Example
This function returns 123.45:

TRUNC(123.456, 2)
This function returns 9800:

TRUNC(9899.435, –2)
See Also

CEILING 
FLOOR 
INT 
MOD 
ROUND 



 TYPE
Description
Returns the argument type of the given expression.
Syntax

TYPE ( expression )
Parameter Description
expression Any expression. 
Remarks
The valid values returned by this argument are:
Number Description
1 Number
2 Text string
4 Logical value
16 Error value
Examples
This function returns 1 if cell A1 contains a number:

TYPE(A1)
This function returns 2:

TYPE("Customer")
See Also

ISBLANK 
ISERR 
ISERROR 
ISLOGICAL 
ISNA 
ISNONTEXT 
ISNUMBER 
ISREF 
ISTEXT 



 UPPER
Description
Changes the characters in the specified string to uppercase characters. 
Syntax

UPPER ( text )
Parameter Description
text Any string.
Remarks
Numeric characters in the string are not changed.
Examples
This function returns 3RD QUARTER:

UPPER("3rd Quarter")
This function returns JOHN DOE:

UPPER("JOHN DOE")
See Also

LOWER 
PROPER 



 USDOLLAR
Description
Returns the specified number as text using the US Dollar format and the supplied precision. Omitting the 
precision argument assumes two decimal places.
Syntax

USDOLLAR (number [,precision])
Parameter Description
number A number, a formula that evaluates to a number, or a reference to a cell that contains a number.
precision A value representing the number of decimal places to the right of the decimal point. Omitting this 
argument assumes two decimal places.
See Also
DOLLAR



 VALUE
Description
Returns the specified text as a number.
Syntax

VALUE ( text )
Parameter Description
text Any text string, a formula that evaluates to a text string, or a cell reference that contains a text string. You 
can also specify a date or time in a recognizable format (for example, M/DD/YY for dates or H:MM AM/PM for time). If
the format is not recognized, #VALUE! is returned.
Examples
This function returns 9800:

VALUE(9800)
This function returns 123:

VALUE("123")
See Also

DOLLAR 
FIXED 
TEXT 



 VAR
Description
Returns the variance of a population based on a sample of values. 
Syntax

VAR ( number_list )
Parameter Description
number_list A list of as many as 30 numbers, separated by commas. The list can contain numbers or a 
reference to a range that contains numbers.
Example
This function returns .31:

VAR(4.0, 3.0, 3.0, 3.5, 2.5, 4.0, 3.5)
See Also

STDEV 
STDEVP 
VARP 



 VARP
Description
Returns the variance of a population based on an entire population of values. 
Syntax

VARP ( number_list )
Parameter Description
number_list A list of as many as 30 numbers, separated by commas. The list can contain numbers or a 
reference to a range that contains numbers.
Example
This function returns .27:

VARP(4.0, 3.0, 3.0, 3.5, 2.5, 4.0, 3.5)
See Also

STDEV 
STDEVP 
VAR 



 VDB
Description
Returns the depreciation of an asset for a specified period using a variable method of depreciation. 
Syntax

VDB ( cost, salvage, life, start_period, end_period [, factor] [, method] )
Parameter Description
cost The initial cost of the asset.
salvage The salvage value of the asset.
life The number of periods in the useful life of the asset.
start_period The beginning period for which to calculate the depreciation. The time units used to determine 
start_period and life must match.
end_period The ending period for which to calculate the depreciation. The time units used to determine 
end_period and life must match.
factor The rate at which the balance declines. Omitting this argument assumes a default of 2, which is the double-
declining balance factor.
method A logical value that determines if you want to switch to straight-line depreciation when depreciation is greater
than the declining balance calculation. Use True to maintain declining balance calculation; use False or omit the 
argument to switch to straight-line depreciation calculation.
Example
This function returns 1041.23:

VDB(10000, 1000, 7, 3, 4)
See Also

DDB 
SLN 
SYD 



 VLOOKUP
Description
Searches the first column of a table for a value and returns the contents of a cell in that table that 
corresponds to the location of the search value. 
Syntax

VLOOKUP ( search_item, search_range, column_index )
Parameter Description
search_item A value, text string, or reference to a cell containing a value that is matched against data in the top 
row of search_range.
search_range The reference of the range (table) to be searched. The cells in the first column of search_range can
contain numbers, text, or logical values. The contents of the first column must be in ascending order (for example, -2, 
-1, 0, 2..., A through Z, False, True). Text searches are not case-sensitive.
column_index The column in the search range from which the matching value is returned. column_index can be a 
number from 1 to the number of rows in the search range. If column_index is less than 1, #VALUE! is returned. When
column_index is greater than the number of rows in the table, #REF! is returned.
Remarks
VLOOKUP compares the information in the first column of search_range to the supplied search_item. 
When a match is found, information located in the same row and supplied column (column _index) is 
returned.
If search_item cannot be found in the first column of search_range, the largest value that is less than 
search_item is used. When search_item is less than the smallest value in the first column of the 
search_range, #REF! is returned.
Examples
The following examples use this worksheet.

This function returns $28,700:
VLOOKUP("Clark", A2:E9, 4)

This function returns 3961:
VLOOKUP("Lee", A2:E9, 3)

See Also
HLOOKUP 
INDEX 
LOOKUP 
MATCH 



 WEEKDAY
Description
Returns the day of the week that corresponds to the supplied date. 
Syntax

WEEKDAY ( serial_number )
Parameter Description
serial_number The date as a serial number or as text (for example, 06-21-94 or 21-Jun-94).
Remarks
WEEKDAY returns a number ranging from 1 (Sunday) to 7 (Saturday).
Examples
This function returns 1, indicating Sunday:

WEEKDAY(34399.92)
This function returns 3, indicating Tuesday:

WEEKDAY("06/21/94")
See Also

DAY 
NOW 
TEXT 
TODAY 



 YEAR
Description
Returns the year that corresponds to the supplied date.
Syntax

YEAR ( serial_number )
Parameter Description
serial_number The date as a serial number or as text (for example, 06-21-94 or 21-Jun-94).
Examples
This function returns 1993:

YEAR(34328)
This function returns 1994:

YEAR("06/21/94")
See Also

DAY 
HOUR 
MINUTE 
MONTH 
NOW 
SECOND 
TODAY 
WEEKDAY 



Check this box to automatically set the width of each column to be wide enough to display the widest data
in the column.



Check this box to display field names instead of the standard alphabetic column headings. Even though 
field names are displayed as the column headings, formulas must still use the standard cell referencing 
conventions (e.g., A1).



Check this box to have formats for date, time, and currency fields set automatically when data is placed in
the worksheet. If you do not check this box, you must set the formats for these columns manually. 



Check this box to have the maximum number of worksheet rows and columns set to the number of 
records and fields returned by the query.



This control displays a set of cell references identifying the current selection on the current worksheet. 
Enter a cell reference here to select a new range and move the active cell to the top left cell in the range. 



This control shows the current display scale for the workbook. Enter a number between 10 and 400 to 
change the display scale.



Check this box to immediately recalculate the worksheet if recalculation is necessary. Thereafter, any 
change to the workbook causes all formulas to be recalculated. Uncheck this box to recalculate the 
worksheet only if you specifically request a recalculation.



Check this box to select an entire row when you click on a cell. Uncheck this box to select only a cell 
when you click on a cell.



Check this box to enable protection for all selected sheets. Uncheck this box to disable protection. 
Enabling protection means that any cells marked as hidden or locked, are actually hidden and locked.



Check this box to cause pressing the enter key to move the active cell down to the next cell. Uncheck this
box to prevent the enter key from moving to the next cell.



The controls in this section specify whether you can use certain mouse actions to perform certain tasks.
Check the Resize Rows/Cols box to allow rows and columns to be resized by dragging row or 

column heading borders.
Check the Fill Range box to fill a worksheet range by dragging a selection's copy handle.
Check the Move Range box to move ranges by dragging a cell.



The controls in this section specify whether you can perform certain editing activities.
Check the Formulas box to allow formulas to be entered.
Check In Cell Editing to allow data to be entered directly into a cell, bypassing the formula bar.
Check the Selections box to allow ranges and objects to be selected with the keyboard or by 

clicking and dragging the mouse.



The controls in this section specify the behavior of certain keyboard actions.
Check Use Arrows to allow use of the arrow keys to reposition the active cell.
Check Use Tabs to allow use the TAB key to reposition the active cell in a selected range.
Check Use Delete to allow use of the DELETE key to delete records and clear selections. The 

DELETE key deletes a record if an entire row is selected. The current selection is cleared if less than a 
row is selected or if data browsing mode is disabled.



Enter the column number of the first column you want to fix in the active worksheet. Fixed columns do not
scroll when the worksheet is scrolled horizontally. Data in fixed columns cannot be edited.



Enter the number of columns (from FixedCol) you want to fix. Fixed columns do not scroll when the 
worksheet is scrolled horizontally. Data in fixed columns cannot be edited.



Enter the row number of the first row you want to fix in the active worksheet. Fixed rows do not scroll 
when the worksheet is scrolled vertically. Data in fixed rows cannot be edited.



Enter the number of rows (from FixedRow) you want to fix. Fixed rows do not scroll when the worksheet is
scrolled vertically. Data in fixed rows cannot be edited.



Enter the number of the first row that can be displayed in the active worksheet. Rows before the first row 
are not displayed but can be used to hold data and formulas.



Enter the number of the first column that can be displayed in the active worksheet. Columns before the 
first row are not displayed but can be used to hold data and formulas.



Enter the number of the last displayable row in the active worksheet. Rows beyond the last row are not 
displayed but can be used to hold data and formulas.



Enter the number of the last displayable column in the active worksheet. Columns beyond the last column
are not displayed but can be used to hold data and formulas.



Check this box to display formula text in cells instead of the values formulas produce. Uncheck the box to 
display formula results. 



Check this box to display grid lines on the active worksheet. Uncheck this box to hide the gridlines.



Check this box to display row headings on the active worksheet. Uncheck this box to hide the row 
headings.



Check this box to display column headings on the active worksheet. Uncheck this box to hide the column 
headings.



Check this box to display zeros in cells with zero values. Uncheck this box to display zero value cells as 
blanks.



Controls the appearance of the vertical scroll bar. Select On to turn the scroll bar on, Off to turn scroll bar 
off, and Automatic to display scroll bar when the workbook is too tall to display in the control.



Controls the appearance of the horizontal scroll bar. Select On to turn the scroll bar on, Off to turn scroll 
bar off, and Automatic to display scroll bar when the workbook is too tall to display in the control.



Controls how selections are displayed on the active worksheet. Select On to display selections, Off to 
hide selections, or Automatic to display selections only when the control has focus.



Controls the appearance and position of sheet name tabs. Select Top to display the tabs at the top of the 
workbook, Bottom to display the tabs at the bottom of the workbook, or Off to hide the sheet tabs.



File    Menu
Items on the File menu allow you to create new files, open existing files, save files, preview and print files,
modify your print and page setup settings, and exit the application. Click on a menu item for more 
information.



Creates a new workbook file and displays it in the SpreadPro workspace.



Opens a workbook file from disk. Files saved in SpreadPro format (.VTS files), Excel 4.0, 5.0, and 7.0 
format (.XLS files), and tabbed text format (.TXT) can be opened.



Closes the active workbook.



Saves the current workbook. Files can be saved in SpreadPro format (.VTS files), Excel 4.0, 5.0, or 7.0 
format (.XLS files), HTML format (.HTM), or tabbed text format (.TXT).



Saves the current workbook under a new name or as a new type.



Displays how the worksheet will print.



Prints the selected worksheets or the entire workbook as a single document.



Displays the Page Setup dialog box. This dialog box allows you to define header and footer text, page 
margins, page print order, page centering, worksheet-related print options, and scale.



Displays the standard Windows Print Setup dialog box. This dialog box allows you to select the printer to 
which the worksheet is sent, the page orientation, and paper size.



List of recently opened workbook files. This eliminates the need for you to search for a file you have 
recently used.



Closes the SpreadPro application.



Edit      Menu
The items on the Edit menu allow you to cut, copy, paste, and clear data; insert and delete cells; and go 
to a specific location in the worksheet. Click on a menu item for more information.



Cuts the current worksheet selection to the clipboard.



Copies the current worksheet selection to the clipboard.



Pastes the contents of the clipboard to the current worksheet selection.



Pastes values from the clipboard to the current worksheet selection. Any formatting applied to the values 
is ignored. In addition, only formula results are pasted; formulas are ignored.



Displays a dialog box that allows you to clear data or objects from the current selection. You can clear 
only formats, only values (including formulas), or both formats and values.



Inserts cells at the location of the current selection. Cells adjacent to the insertion are shifted to make 
room for the new cells.
If you use the keyboard shortcut CTRL + I, the selected cells are shifted right to make room for the 
inserted cells. If you use SHIFT + CTRL + I, the selected cells are shifted down.



Deletes the current selection. Cells adjacent to the deleted cells are shifted to fill the space left by the 
vacated cells.
If you use the keyboard shortcut CTRL + K, cells to the right of the selected cells are shifted left to fill the 
space left by the vacated cells. If you use SHIFT + CTRL + K, cells below the selected cells are shifted 
up.



Data in the leftmost cell of the selected range is copied right to fill the range.



Data in the top cell of the selected range is copied down to fill the range.



Displays the Goto dialog box. This dialog box allows you to specify a cell to display in the worksheet 
window. The specified cell is made the active cell.



View      Menu
Items on the View menu allow you to toggle the display of various tool bars and control basic formatting 
information for the workbook. Click on a menu item for more information.



Toggles the display of the main toolbar.



Toggles the display of the drawing toolbar. 



Toggles the display of the formula bar.



Toggles the display of the format bar.



Toggles the display of the status bar.



Options
Displays the Options dialog box as shown in the following illustration. Click on any tab or control for more 
information.



The controls in this section specify whether you can use certain mouse actions to perform certain tasks. 
Check the Resize Rows/Cols box to allow rows and columns to be resized by dragging row or 

column heading borders.
Check the Fill Range box to fill a worksheet range by dragging a selection's copy handle.
Check the Move Range box to move ranges by dragging a cell.



The controls in this section specify whether you can perform certain editing activities.
Check the Formulas box to allow formulas to be entered.
Check In Cell Editing to allow data to be entered directly into a cell, bypassing the formula bar.
Check the Selections box to allow ranges and objects to be selected with the keyboard or by 

clicking and dragging the mouse.



The controls in this section specify the behavior of certain keyboard actions.
Check Use Arrows to allow use of the ARROW keys to reposition the active cell.
Check Use Tabs to allow use of the TAB key to reposition the active cell in a selected range.
Check Use Delete to allow use of the DELETE key to delete records and clear selections. The 

DELETE key deletes a record if an entire row is selected. The current selection is cleared if less than a 
row is selected or if data browsing mode is disabled.

Check Enter Moves Down to cause pressing the ENTER key to move the active cell down to the 
next cell.



Options
Displays the Options dialog box as shown in the following illustration. Click on any tab or control for more 
information.



Check this box to display formula text in cells instead of the values formulas produce. Uncheck the box to 
display formula results. 



Check this box to display gridlines on the active worksheet. Uncheck this box to hide the gridlines.



Check this box to display row headings on the active worksheet. Uncheck this box to hide the row 
headings.



Check this box to display column headings on the active worksheet. Uncheck this box to hide the column 
headings.



Check this box to display zeros in cells with zero values. Uncheck this box to display zero value cells as 
blanks.



Controls the appearance of the vertical scroll bar. Select On to turn the scroll bar on, Off to turn scroll bar 
off, and Automatic to display scroll bar when the workbook is too tall to display in the control.



Controls the appearance of the horizontal scroll bar. Select On to turn the scroll bar on, Off to turn scroll 
bar off, and Automatic to display scroll bar when the workbook is too wide to display in the control.



Controls how selections are displayed on the active worksheet. Select On to display selections, Off to 
hide selections, or Automatic to display selections only when the control has focus.



Controls the appearance and position of sheet name tabs. Select Top to display the tabs at the top of the 
workbook, Bottom to display the tabs at the bottom of the workbook, or Off to hide the sheet tabs.



Enter the number of the first row that can be displayed in the active worksheet. Rows before the first row 
are not displayed but can be used to hold data and formulas.



Enter the number of the first column that can be displayed in the active worksheet. Columns before the 
first row are not displayed but can be used to hold data and formulas.



Enter the number of the last displayable row in the active worksheet. Rows beyond the last row are not 
displayed but can be used to hold data and formulas.



Enter the number of the last displayable column in the active worksheet. Columns beyond the last column
are not displayed but can be used to hold data and formulas.



This control shows the current display scale for the workbook. Enter a number between 10 and 400 to 
change the display scale.



Enter the column number of the first column you want to fix in the active worksheet. Fixed columns do not
scroll when the worksheet is scrolled horizontally. Data in fixed columns cannot be edited.



Enter the number of columns (from FixedCol) you want to fix. Fixed columns do not scroll when the 
worksheet is scrolled horizontally. Data in fixed columns cannot be edited.



Enter the row number of the first row you want to fix in the active worksheet. Fixed rows do not scroll 
when the worksheet is scrolled vertically. Data in fixed rows cannot be edited.



Enter the number of rows (from FixedRow) you want to fix. Fixed rows do not scroll when the worksheet is
scrolled vertically. Data in fixed rows cannot be edited.



Check this box to prevent users from scrolling past the last filled row or column on the worksheet.



Data      Menu
The items on the Data menu allow you to control worksheet calculation, create defined names, sort data, 
and create autofill lists. Click on a menu item for more information.



Recalculates the workbook.



Displays the Calculation dialog box. This dialog box allows you to enable and disable automatic 
recalculation and specify iteration values for calculating circular references.



Displays the Define Name dialog box. This dialog box allows you to add and delete user-defined names.



Displays the Sort dialog box. This dialog box allows you to set the sorting method and sort keys for data 
sorting.



Displays the AutoFill List dialog box. This dialog box allows you to add, delete, or edit autofill lists.



Sheet      Menu
Items on the Sheet menu allow you to set print area, titles, and page breaks; insert and delete 
worksheets; modify the color palette used by the worksheet; set the worksheet's default font; enable 
protection; fix rows and columns; and enable or disable compression. Click on a menu item for more 
information.



Defines the currently selected range in the active worksheet as the Print_Area user-defined name.



Defines the currently selected range in the active worksheet as the Print_Titles user-defined name. 



Places a horizontal page break adjacent to the top edge of the active cell and a vertical page break 
adjacent to the left edge of the active cell. If a row or column is selected, a page break is placed adjacent 
to the selected row or column.



This command replaces Set Page Breaks if page breaks are adjacent to the active cell. Removes page 
breaks adjacent to the top edge and left edge of the active cell.



Inserts one or more worksheets. The number and position of inserted worksheets is determined by the 
number of selected worksheets. This command fails if non-contiguous sheets are selected.



Deletes the selected worksheets.



Displays the Color Palette dialog box. This dialog box allows you to edit colors in the color palette, specify
a default color, and use the default color palette.



Displays the Default Font dialog box. This dialog box allows you to set the default font used to display 
data in worksheets. In addition to setting the font and font size used to display data in a worksheet, the 
default font affects the widths of worksheet columns. Column widths can be set in units equal to 1/256th 
of the character 0 (zero) in the default font.



Enables protection for protected cells in the worksheet. A check next to this command means that 
protection is enabled. Select the command again to disable protection.



Fixes the selected columns or rows. Fixed columns and rows do not scroll and cannot be edited. If you 
select fixed rows or columns, this command is replaced by the Unfix Rows + Columns command.



Format      Menu
Items on the Format menu allow you to format worksheet elements. Click on a menu item for more 
information.



Displays the Alignment dialog box. This dialog box allows you to specify the horizontal and vertical 
alignment of data in the selected range. In addition, you can enable and disable word wrapping.



Displays the Font dialog box. This dialog box allows you to specify the font, point size, font style, and 
color of data in the selected range.



Displays the Border dialog box. This dialog box allows you to specify the placement of borders in the 
selected range. In addition, you can specify the border line style and color.
The check boxes in the Border dialog box are three-state check boxes, allowing "as is" selections to be 
made.



Displays the Pattern dialog box. This dialog box allows you to specify the fill pattern and foreground and 
background colors for the selected fill pattern.



Displays the Cell Protection dialog box. This dialog box allows you to specify whether the cells in the 
selected range are locked and/or hidden.



Formats data in the selected range with the general format.



Formats data in the selected range with the currency format and a decimal precision of 0.



Formats data in the selected range with the currency format and a decimal precision of 2.



Formats data in the selected range with the fixed format.



Formats data in the selected range with the percent format. Numbers with this format are displayed as 
percentages with a trailing percent sign (%).



Formats data in the selected range with the fraction format. Numbers with this format are displayed as 
fractions. 



Formats data in the selected range with the scientific format.



Formats data in the selected range with the short date format. Numbers with this format are displayed as 
dates.



Formats data in the selected range with the H:MM AM/PM time format. Numbers with this format are 
displayed as times.



Displays the Custom Number dialog box. This dialog box allows you to define custom number formats for 
data in the selected range.



Displays the Validation Rule dialog box. This dialog box allows you to create or edit the validation rule for 
the current selection.



Displays the Column Width dialog box. This dialog box allows you to set the width of the selected 
columns, specify default column widths, and use the default width.



Displays the Row submenu.



Object      Menu
The items on the Object menu allow you to format and manipulate objects on a worksheet. Click on an 
item for more information.



Displays the Pattern dialog box. This dialog box allows you to set the fill pattern and colors for the 
selected objects.



Displays the Line Style dialog box. This dialog box allows you to set the line style, width, and colors for 
the selected line object or the border surrounding the selected arcs, ovals, polygons, and rectangles.



Displays the Object Name dialog box. This dialog box allows you to set a name for the selected object.



Displays the Object Option dialog box. This dialog box allows you to set the input value cell for selected 
check boxes and list boxes, the text displayed by check boxes and buttons, and the list of items contained
by list boxes.



Places the selected objects in front of other objects in the worksheet.



Places the selected objects behind other objects in the worksheet.



Selects all the objects in the worksheet.



Window      Menu
The items on the Window menu allow you to create new views of a workbook and manipulate workbook 
windows. Click on an item for more information.



Creates a new view of the active workbook. The view is identified by workbook name:view number. For 
example Sales:2 indicates the second view of a workbook named sales.



Arranges all open windows in a cascading pattern, one on top of the other.



Arranges all open window side by side so that they share a portion of the SpreadPro workspace.



Arranges the icons representing minimized workbooks neatly beginning at the bottom of the SpreadPro 
workspace.



Lists all open windows within the SpreadPro workspace. Select a window from the list to make it the 
active window.



Help      Menu
The items on the Help menu provide information about SpreadPro.



Displays the SpreadPro help file.



Displays the About SpreadProSpreadProbox with information about this version of SpreadPro.



Main      Toolbar
The buttons on the Main Toolbar provide easy access to some of the most common SpreadPro menu 
items. Click on a button for more information.



The Format Painter allows you to quickly and easily copy formatting from one selection to another. 
1. Select the range of cells containing the formatting you want to copy.
2. Click on the Format Painter button.
3. Select the range to which you want to apply the format.



Drawing      Toolbar
Use the buttons on the Drawing Toolbar to draw or manipulate objects on a worksheet. Click on a button 
for more information.



The worksheet tool performs standard worksheet editing. It also selects objects for editing. Press CTRL 
when selecting buttons, check boxes, and drop down list boxes.



The polygon editing mode tool toggles between normal polygon editing and polygon point editing mode. 
When polygon point editing is enabled, the points of a polygon can be moved.



The line tool draws lines.



The rectangle tool draws rectangles and squares.



The oval tool draws ovals and circles.



The arc tool draws arcs.



The polygon tool draws polygons.



The button tool draws push buttons.



The check box tool draws check box objects.



The list box tool draws drop-down list box objects.



The chart tool charts the selected range of data.



Format      Bar
Use the buttons on the Format bar to quickly and easily format select worksheet data. Click on a button 
for more information.



Select a font for the currently selected range of data.



Select a font size for the currently selected range of data.



Controls the bold attribute for the currently selected range of data.



Controls the italic attribute for the currently selected range of data.



Controls the underline attribute for the currently selected range of data.



Select a color for the currently selected range of data.



Applies general alignment to the selected range of data. 



Left aligns the selected range of data.



Centers the selected range of data.



Right aligns the selected range of data.



Centers the selected data across the number of selected cells. This is useful for straddling heading 
information across rows or columns.



Displays a list of common fixed and general formats. Select a format to apply it to the selected range of 
data.



Formats data in the selected range with the currency format and a decimal precision of 2.



Displays a list of common percent formats. Select a format to apply it to the selected range of data.



Displays a list of common fraction formats. Select a format to apply it to the selected range of data.



Displays a list of common date and time formats. Select a format to apply it to the selected range of data.



Displays a dialog box that allows you to find data.



Displays a dialog box that allows you to replace data.



Automatically resizes the column width to display the widest cell.



Hides the selected row(s) or column(s) from view.



Displays the selected row(s) or column(s).



Displays the Column Width dialog box. This dialog box allows you to set the default column width.



Displays the Row Height dialog box. This dialog box allows you to set the height of the selected rows, 
specify default row heights, and use the default row height. 



Displays the Row Height dialog box. This dialog box allows you to set the default row height.



Enter your registration unlock code here.



Allows you to zoom in and out by the specified percentage.



Displays the function picker window.



Undoes your last action.



Displays the rename dialog, allowing you to rename the current worksheet.



Autoformat
To format an entire list or other large range that has distinct elements, for example, column and row 
labels, summary totals, and detail data, you can apply a built-in table design, called an autoformat. The 
design uses distinctive formats for the various elements of the table.

To autoformat a selection:
1. Select the cells you want to format.
2. Select Autoformat from the Format menu.
3. Select the format you would like to apply.
4. Click on the OK button.



Evaluation Version
The unregistered version of SpreadPro allows you to evaluate the product for 30 days. After this time if 
you wish to continue using the product you must register.

Registering SpreadPro
Unlocking SpreadPro



Registering SpreadPro
Registration details can be found in the document REGISTER.DOC, and can be accessed from the 
SpreadPro under the Start menu.

Alternatively details can be obtained from the SpreadPro web site at:

            www.techmarc.ndirect.co.uk

Registration may be performed on-line via the internet or by post or fax. On registration you will receive 
an unlock code to remove the 30 day evaluation period. You will now also be elligble for free unlimited e-
mail technical support and free maintenance releases.

Unlocking SpreadPro



Unlocking SpreadPro
To unlock SpreadPro:

1. Select Unlock from the Help menu.
2. Enter your unlock code and click on OK.

If you have entered the unlock code correctly then the message "SpreadPro Unlocked" will be displayed. 
If you have mistyped the unlock code the message "Invalid Unlock Code" will be displayed and you then 
need to re-enter the code.



Function Picker
The function picker allows you to easily find and insert a function into a worksheet.

Down the left hand side is displayed the function categories. When a category is selected the 
corresponding functions are displayed on the right. When a function is highlighted, its syntax and 
description are displayed at the bottom of the screen.

To insert the selected function, click the OK button.



Formatting Toolbar
The buttons on the formatting Toolbar provide easy access to some of the most common SpreadPro 
menu items. Click on a button for more information.



Controls Toolbar
The buttons on the formatting Toolbar provide easy access to some of the most common SpreadPro 
menu items. Click on a button for more information.



Set the background color for the selected cells.



Sets the font color for the selected cells.



Displays SpreadPro full screen providing the largest work area.



Toggles the selected toolbar on and off.



Allows the selected object to be inserted into the worksheet.



Starts the spell checker.



Tools Menu
Items on the Tools menu allow you to format worksheet elements. Click on a menu item for more 
information.



Displays the autoformat dialog.



Insert Menu
Items on the Insert menu allow you to format worksheet elements. Click on a menu item for more 
information.



Auto sums the currently selected columns.



Sort the data in ascending order.



Sort the data in descending order.



Formats data in the selected range with the long date format. Numbers with this format are displayed as 
dates.



Format Painter
If you've already formatted some cells on a worksheet the way you want, you can copy the formatting to 
other cells using the Format Painter.

1 Select a cell or range that has the formatting you want to copy.
2 Click on the Format Painter    button.
3 Select the cell or range you want to copy the formatting to.



Formats data in the selected range with the time format. Numbers with this format are displayed as times.



Creating a New Workbook
To cerate a new workbook select New from the File menu.




